Contents

Preface 9
  Intended audience 9
  Prerequisites 9
  Document conventions and symbols 9
  Customer Support 9

1 Safety Precautions 11
  General 11
  Safety Definitions 11
  Caution Messages 11
    Caution Messages about Disks 11
    Caution Messages about Arrays 12

2 Getting Started 13
  RAIDXpert2 Technology 13
  Who Should Use This Manual 13
  System Requirements for Using RAIDXpert2 13
  Supported Controllers 13
  Supported Operating Systems 13
  Features of RAIDXpert2 14
  RAIDXpert2 Feature Set 16

3 Arrays, Disks, and RAID Levels 19
  Understanding Arrays 19
    RAID Levels 19
    Array States 20
    Creating Arrays: Future Expansion 21
    Expanding Disk Capacity Online: Using OCE (supported by RAIDXpert2 Plus) 21
    Migrating RAID Levels Online: Using ORLM (supported by RAIDXpert2 Plus) 21
    Array Tasks: Starting and Stopping Tasks 22
  Understanding Disks 22
    Disks States 22
    Rescanning Disks for Changes in State 23
  Sparing Options: Disks and Arrays 24
    Dedicated Spacing 24
    Global Spacing 24
  RAID Performance Considerations 25
    Number and Organization of Disks 25
    Caching Attributes 25
    Application Workload 25
  RAID Reliability Considerations 25
    Data Redundancy 25
    Backup 25
  Flexibility and Expansion Considerations 25
    Multiple RAID Levels 25
    RAIDABLE Arrays 26

4 BIOS Configuration Utility 27
  When to Use the AMD-RAID Controller BIOS Configuration Utility 27
  Access the AMD-RAID Controller BIOS Configuration Utility 27
  Understanding the Color Code in the BIOS Configuration Utility 27
  Initialize Disks 28
    Initialize Disks 28
  Create Arrays 28
    Before you begin... 28
    Create An Array 29
Delete Arrays 30
  Delete an Array 30
Swap Arrays 30
  Before you begin... 30
  Swap Arrays 31
Manage Spares 31
  Assign Global Spares 31
  Assign Dedicated Spares 31
  Unassign Spares 31
View Disk Details 32
View Array Details 32
Rescan All Channels 32
Change the Controller Options 32
  Booting the system from an array 33
  Pausing the boot sequence for warning messages 33
  Change the Staggered Spinup Count 33
Continue Booting from the BIOS Configuration Utility 33
  Resume the Boot Process 33

5 Software Installation35
System setup process overview 35
Before you begin... 35
Copying AMD-RAID drivers to removable storage 35
  Copying AMD-RAID drivers in a Microsoft Windows environment 35
  Copying AMD-RAID drivers in a Linux environment 35
Pre-installation steps 36
  BIOS Mode 36
  UEFI Mode 36
Installing AMD-RAID drivers 37
  Installing AMD-RAID drivers while installing Microsoft Windows 37
  Installing AMD-RAID drivers while installing Linux 38
Installing the AMD RAIDXpert2 Management Suite for Microsoft Windows 41
Installing the AMD RAIDXpert2 Management Suite for Linux 42
Installing the AMD RAIDXpert2 Graphical User Interface (GUI) 43
  SLED Linux 43
  Ubuntu Linux 43

6 AMD RAIDXpert2 Graphical User Interface (GUI)45
Start RAIDXpert2 45
  Web-browser Access 45
  Windows Shortcut Access 45
Password Protection 46
  Things to Know About Passwords 46
  Change a Password at the Options Menu 46
Help and About Windows 46
Reviewing the RAIDXpert2 GUI 47
  The Array View Section of the Array Status Window 47
  The Disk List Section of the Array Status Window 47
  The Array List Section of the Array Status Window 48
  The Event View Section of the Array Status Window 49
Array and Disk Commands 49
Working with Disks 50
  Initialize Disks 50
  Rescan Disks 51
  Change Cache Properties for Disks 51
  Assign Spares 51
  Legacy Disks 52
Working with Arrays 52
  Create and Format Arrays 52
  Name Arrays 54
Transform Arrays (supported by RAIDXpert2 Plus) 54
Restore (Rebuild) Arrays 56
Prepare to Physically Remove an Array 57
Delete Arrays 57
Change Cache Settings for Arrays 58
Change the Priority Level of a Task 59
Interrupt, Cancel, or Resume a Task 59
Check for Consistency 59
Schedule a Consistency Check 60
Scan an Array in the Background 61
Add or Remove Dedicated Spares 61
Add or Remove Global Spares 61
Use Mirror to Split an Array 62
Hide an Array 62
Copy an Array 62
Unlink Arrays 62
Secure Erase 63
Working with Views 63
Display or hide Controller Event Log panel 63
Log Window 63
Refresh the Display 63
Working with Options 63
Change Password Settings 63
Set Event Notifications 64
Licensing 64
Add space using a RAIDABLE Array 64

7 Troubleshooting 67
Troubleshooting 67
System Startup Problems 67
Warning Messages: POST Screen 68
Array-Related Errors 69
Disk-Related Errors 72
Troubleshooting Disks 73

8 Software License: EULA 75
Software License: End-User License Agreement (EULA) 75
1. Limited License to Authorized Distributors 75
2. Limited License to End Users 75
3. Restrictions 75
4. Proprietary Rights 76
5. Term and Termination 76
6. No Warranty 76
7. Limitation of Liability 76
8. Export Controls 76
9. General 77

9 rcadm Command Line Interface Tool 79
What is rcadm? 79
To Use rcadm with a Linux OS 79
To Use rcadm with a Windows OS 79
Manage Arrays and Disks: rcadm --manage 80
Understand Query Output 80
rcadm Controller List Elements 80
rcadm Disk List Elements 80
rcadm Array List Elements 81
View Help from the Command Line 82
Create New Arrays: rcadm --create 82
Before you begin... 83
Example 83
Delete Arrays: `rcadm --delete` 83
   Before you begin... 83
   Example 83
Transform Arrays: `rcadm --transform` (supported by RAIDXpert2 Plus) 83
   Before you begin... 83
Follow or Monitor Arrays and Disks: `rcadm --follow` 84
   Before you begin... 84

Glossary 85
Index 87
# Tables

1. Document conventions 9
2. System requirements for RAIDXpert2 13
3. Features of RAIDXpert2 14
4. Feature set for RAIDXpert2: by RAIDXpert2 license level 16
5. RAID levels - general characteristics 19
6. Array states 20
7. Failure states by RAID level 20
8. Array expansion considerations 21
9. Types of tasks per array 22
10. Disk states 23
11. Sparing options 24
12. When to use the AMD-RAID Controller BIOS Configuration Utility (Option ROM) 27
13. BIOS Configuration Utility color codes 27
14. Linux procedure for installing the Management Suite 42
15. Elements of the Array View section, Array Status window 47
16. Elements of the Disk List section, Array Status window 47
17. Elements of the Array List section, Array Status window 48
18. Elements of the Event View section, Array Status window 49
19. Commands at the Array and Disk menus 50
20. New and legacy disks, as they appear in the BIOS Configuration Utility and RAIDXpert2 52
22. Transforming arrays: Issues and recommendations 55
23. Deleting arrays: Issues and recommendations 58
24. Cache array options 58
25. Consistency Check options 60
26. Event Log priority levels 64
27. The system does not boot 67
28. The BIOS Configuration Utility does not display 67
29. Username and password 67
30. POST screen warning messages 68
31. Cannot create an array 69
32. An array is in a Critical state 69
33. An array is in an Offline state 70
34. Cannot assign a dedicated spare to an array 70
35. Cannot create a global spare 70
36. Cannot create an array larger than 2.199 TB 71
37. Recreate a deleted array 72
38. Disk errors 72
39. Modes for the rcadm program 79
40. rcadm Controller List elements 80
41. rcadm Disk List elements 80
42. rcadm Array List elements 81
Preface

This user guide:
- Provides information about arrays, disks, and RAID levels (RAID types).
- Describes how to improve storage system performance or reliability by understanding array and disk tasks and options.
- Describes how to acquire and load RAIDXpert2 drivers for Windows and Linux operating systems.
- Describes the features and procedures for using RAIDXpert2, which is the RAIDXpert2 GUI.

Intended audience

This user guide is intended for use by system administrators and technicians who are experienced with the following:
- Direct Attached Storage (DAS), Storage Area Network (SAN), or Network Attached Storage (NAS) operators
- Network administration
- Network installation
- Storage system installation and configuration

Prerequisites

Prerequisites for installing and configuring this product include familiarity with:
- Servers and computer networks
- RAID and input/output signal technology (such as SCSI, or SATA)
- Fibre Channel and Ethernet protocols

Document conventions and symbols

<table>
<thead>
<tr>
<th>Convention</th>
<th>Element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navy blue text: Figure 1</td>
<td>Cross-reference links and e-mail addresses</td>
</tr>
<tr>
<td>Navy blue, underlined text</td>
<td>Web site addresses</td>
</tr>
<tr>
<td>(<a href="http://www.example.com">http://www.example.com</a>)</td>
<td></td>
</tr>
<tr>
<td><strong>Bold font</strong></td>
<td>Key names</td>
</tr>
<tr>
<td></td>
<td>Text typed into a GUI element, such as into a box</td>
</tr>
<tr>
<td></td>
<td>GUI elements that are clicked or selected, such as menu and list items, buttons, and check boxes</td>
</tr>
<tr>
<td><em>Italics font</em></td>
<td>Text emphasis</td>
</tr>
<tr>
<td>Monospace font</td>
<td>File and directory names</td>
</tr>
<tr>
<td></td>
<td>System output</td>
</tr>
<tr>
<td></td>
<td>Code</td>
</tr>
<tr>
<td></td>
<td>Text typed at the command-line</td>
</tr>
<tr>
<td><strong>Monospace, italic font</strong></td>
<td>Code variables</td>
</tr>
<tr>
<td></td>
<td>Command-line variables</td>
</tr>
<tr>
<td><strong>Monospace, bold font</strong></td>
<td>Emphasis of file and directory names, system output, code, and text typed at the command line</td>
</tr>
</tbody>
</table>

Customer Support

For customer support, contact your system supplier or motherboard vendor.
1 Safety Precautions

General
This section includes general safety precautions and specific RAIDXpert2 cautions. Read and keep this user manual for future reference.

Safety Definitions

△ CAUTION: Indicates that failure to follow directions could result in damage to equipment or data.

☞ IMPORTANT: Provides clarifying information or specific instructions.

☞ NOTE: Provides additional information.

☞ TIP: Provides helpful hints and shortcuts.

Caution Messages
This section lists the Caution messages that appear in the book.

Caution Messages about Disks

△ CAUTION: Assigning a dedicated spare does not reserve space on the disk. Therefore, an automatic restore is not guaranteed if a disk fails. If a disk fails, make space on the disk for the fail-over to complete, or assign a different disk with enough space. If a dedicated spare is assigned and a disk fails, the restore process starts automatically, if there is enough space available on the dedicated spare.

△ CAUTION: If a disk is part of an AMD-RAID array, the disk cannot be selected for initialization. To initialize the disk anyway, delete the AMD-RAID array. Data on the disk is deleted during initialization so ensure the correct disks are chosen to initialize.

△ CAUTION: A legacy disk can contain valid data. When a legacy array is deleted, or when its corresponding legacy disk is initialized, the data is lost.

△ CAUTION: When a disk is initialized, all data on the disk is lost.
Caution Messages about Arrays

⚠️ **CAUTION:** Deleting an array permanently destroys all data that is on the array. This action cannot be undone and it is very unlikely the data can be recovered.

⚠️ **CAUTION:** Do not delete the first array listed in the Arrays section, if it is the AMD-RAID bootable array. Doing this deletes the operating system and AMD-RAID files.

⚠️ **CAUTION:** Do not initialize a disk that is part of an array. Initializing a disk in a non-redundant array deletes the array and its data. The array no longer appears in Array View. This is especially true for a non-redundant bootable array. Initializing a disk in a non-redundant bootable array causes the array to Fail and deletes the operating system, RAIDXpert2 files, and device drivers.

⚠️ **CAUTION:** Leaving Write Back Cache enabled can increase the likelihood of data being corrupted if the system experiences a power interruption or unexpected shutdown.

⚠️ **CAUTION:** Prior to removing an array, remove its drive letter (Windows) or unmount the array (Linux).

⚠️ **CAUTION:** All data contained in a RAIDXpert2 array are lost if the RAIDXpert2 disks of the array are migrated to a non-RAIDXpert2 system.

⚠️ **CAUTION:** When an array is securely erased, the data on the array is lost.

⚠️ **CAUTION:** In some circumstances, more than eight arrays are possible. They might appear to function properly, but are not supported.

⚠️ **CAUTION:** Creating a redundant array with Skip Initialization selected can result in data corruption.
2 Getting Started

RAIDXpert2 Technology

RAIDXpert2 consists of (a) storage management and (b) a RAID controller and port virtualization. RAIDXpert2 runs on existing systems by using a motherboard’s built-in SATA ports.

Who Should Use This Manual

Only trained, experienced, and authorized personnel should install RAIDXpert2 and use its features and capabilities.

All unit operators must be familiar with system hardware, data storage, RAID technology, input/output signal technology (such as SCSI, SAS, or SATA), and Direct Attached Storage (DAS), Network Attached Storage (NAS), and/or Storage Area Network (SAN) concepts and technology.

The intended user audience of this user manual is system administrators and experienced users.

System Requirements for Using RAIDXpert2

Make sure the systems that use RAIDXpert2 meet the requirements indicated in Table 2.

Table 2 System requirements for RAIDXpert2

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory (RAM)</td>
<td>Minimum: 1 GB. Recommended: 2 GB.</td>
</tr>
<tr>
<td>Hard disk</td>
<td>1-12 SATA or SSD drives. The number of disks depends on the number, type, and capacity of the arrays to be created. In some circumstances, more than 12 disks are possible. They might appear to function properly, but are not supported by AMD-RAID.</td>
</tr>
</tbody>
</table>

Supported Controllers

The following controllers are supported by the current release of RAIDXpert2:

- A8x Series
- A7x Series

Supported Operating Systems

The following operating systems are supported by the current release of RAIDXpert2:

- Microsoft Windows® 8: 32-bit and 64-bit.
- Microsoft Windows® XP: 32-bit SP3.
- SUSE® Linux Enterprise Desktop 10 SP4 and 11 SP2; 32-bit and 64-bit.
- Ubuntu® Desktop: 12.04.1 and 12.10; 32-bit and 64-bit.
The features of RAIDXpert2 described in this user manual apply to all license levels and supported operating systems. See Supported Operating Systems.

Table 3 describes these features. Also see Table 4 for a summary of features that are available with each license level of RAIDXpert2: RAIDXpert2 Basic, RAIDXpert2 Plus, RAIDXpert2 VST, and RAIDXpert2 VST Plus.

**Table 3  Features of RAIDXpert2**

<table>
<thead>
<tr>
<th>RAIDXpert2 Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrays (general information)</td>
<td>RAIDXpert2 allows:</td>
</tr>
<tr>
<td></td>
<td>• Creating arrays of different RAID levels using the same disks.</td>
</tr>
<tr>
<td></td>
<td>• Creating different RAID level arrays on the same disk, to adapt each array to the I/O that it processes.</td>
</tr>
<tr>
<td></td>
<td>• Creating an array from a mix of different-type disks. For example, a RAID10 array can be created from a group of disks that contain two SATA II HDDs and two SATA SSDs.</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>The ability to create RAID10 or RAIDABLE arrays may not be available on your system.</td>
</tr>
<tr>
<td></td>
<td>• Migrating an existing array to another RAID level, if the type of array being used is not the optimal type for the application. This function depends on the array capacity and redundancy level.</td>
</tr>
<tr>
<td></td>
<td>An array refers to data storage created by RAIDXpert2 from one or more disks. Although an array can be created from several disks, it is seen by the operating system as a single disk.</td>
</tr>
<tr>
<td>Array hiding</td>
<td>An array can be hidden from the operating system so that neither the software nor users can see or access it.</td>
</tr>
<tr>
<td>Array recovery</td>
<td>If an array is accidentally deleted, it might be recovered by creating a new array with the same properties as the deleted array. (This can occur only if disk Write Access operations are not in-progress.)</td>
</tr>
<tr>
<td>Background array initialization (BGI)</td>
<td>The background initialization of a redundant array creates the redundant data that allows the array to survive a disk failure.</td>
</tr>
<tr>
<td></td>
<td>Background initialization allows a redundant array to be used immediately. Data is not lost if a disk goes offline prior to completion of the BGI process.</td>
</tr>
<tr>
<td>Cache support for arrays</td>
<td>Various array-caching options are supported: No Cache, Read Cache, Write Back Cache, Read + Write Back Cache.</td>
</tr>
<tr>
<td>Cache support for disks</td>
<td>Various disk-caching options are supported: No Cache, Disk Read Ahead Cache, Disk Write Back Cache, Disk Read Ahead + Write Back Cache.</td>
</tr>
<tr>
<td>Secure Erase</td>
<td>All data on an array can be erased and ensured it is unrecoverable, even with advanced data recovery techniques.</td>
</tr>
<tr>
<td>Consistency Check</td>
<td>A Consistency Check is a background operation that verifies and corrects the mirror or parity data for fault-tolerant disks. It is recommended that a Consistency Check be run periodically on an array.</td>
</tr>
<tr>
<td></td>
<td>Consistency Check automatically corrects mirror or parity inconsistencies.</td>
</tr>
<tr>
<td></td>
<td>A Consistency Check can be scheduled or started manually by the system user.</td>
</tr>
</tbody>
</table>
Disk roaming

With disk roaming, SATA cables can be disconnected from their disks and shuffled without confusing RAIDxpert2.

**NOTE:** Disconnect the SATA cables from the disks only when the system is shutdown.

Disk roaming also allows:

- Disks to be moved to different slots in the backplane. RAIDxpert2 detects which disks belong to which arrays, regardless of where the disks are moved in the backplane.
- Disk(s) to be moved between systems.

**NOTE:** It might not be possible to move disks between systems in boot arrays.

Fault tolerance

The following fault tolerance features are available with RAIDxpert2, in order to prevent data loss in case of a failed disk.

- Disk failure detection (automatic).
- Array rebuild using hot spares (automatic, if the hot spare is configured for this functionality).
- Parity generation and checking (RAID5 only).
- Hot-swap manual replacement of a disk without rebooting the system (available only for systems with a backplane that supports hot-swapping).

For example if a disk fails in RAID1, the array remains functional and data is read from the surviving mirrored disk.

Mirror rebuilding

A broken mirrored array can be rebuilt after a new disk is inserted and the disk is designated as a spare. The system does not have to be rebooted.

Multiple RAID levels per disk

Support for multiple array levels per disk allows the administrator to create arrays of different RAID levels using the same disks.

Native Command Queuing (NCQ)

Native Command Queuing is a command protocol of disks that are supported by RAIDxpert2. NCQ enables individual disks to internally optimize the order in which Read and Write commands are executed. RAIDxpert2 permits a queue depth of up to 32 read/write commands per disk.

Online Capacity Expansion (OCE)

OCE is a process that allows the user to add storage capacity to an existing array, without taking the system offline. OCE enables the user to increase the total storage capacity of an array by integrating unused storage into the array.

Data can be accessed while the disks are added and while data on the array is being redistributed.

**NOTE:** This feature is not available with all license levels. See Table 4.
Table 3  Features of RAIDXpert2 (continued)

<table>
<thead>
<tr>
<th>RAIDXpert2 Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online RAID Level Migration (ORLM)</td>
<td>With online RAID level migration, users can easily move an array from one RAID level to another. While the migration is taking place, data is accessible and protected to the lowest protection of either the source RAID level or the destination RAID level.</td>
</tr>
<tr>
<td>RAID Level Support</td>
<td>RAIDXpert2 supports RAID levels 0, 1, 5, 6, 10, Volume, and RAIDABLE.</td>
</tr>
<tr>
<td>Self-Monitoring Analysis and Reporting Technology (SMART)</td>
<td>SMART is a hard-disk-drive (HDD) capability which allows reporting of reliability information. If a drive anticipates there is a high likelihood of future failure it triggers a SMART error condition. RAIDXpert2 presents this error condition so the drive can be replaced before the predicted failure occurs.</td>
</tr>
</tbody>
</table>

RAIDXpert2 Feature Set

**IMPORTANT:** The supported feature set (for RAIDXpert2 Basic, RAIDXpert2 Plus, RAIDXpert2 VST, or RAIDXpert2 VST Plus) is determined by the license level that is included in the system BIOS. Refer to the system’s motherboard specifications for the supported features.

Table 4  Feature set for RAIDXpert2: by RAIDXpert2 license level

<table>
<thead>
<tr>
<th>Features</th>
<th>Sub-Features</th>
<th>RAIDXpert2 Basic</th>
<th>RAIDXpert2 Plus</th>
<th>RAIDXpert2 VST</th>
<th>RAIDXpert2 VST Plus</th>
</tr>
</thead>
<tbody>
<tr>
<td>O-ROM (BIOS) supporta</td>
<td>Create array</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Delete array</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Boot/INT13 control</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Features</td>
<td>Sub-Features</td>
<td>RAIDXpert2 Basic</td>
<td>RAIDXpert2 Plus</td>
<td>RAIDXpert2 VST</td>
<td>RAIDXpert2 VST Plus</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------------</td>
<td>------------------</td>
<td>-----------------</td>
<td>----------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>RAID levels supported&lt;sup&gt;b&lt;/sup&gt;</td>
<td>0</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>1n</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>10n</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>50</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>RAIDABLE</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Volume</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Array creation</td>
<td>No initialization</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Foreground initialization</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Background initialization</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Array deletion</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Array transformation</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Array copy</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Mirror</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Sparing</td>
<td>Global</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Dedicated</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Consistency check</td>
<td>Background</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Scheduled</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Copy</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Mirror split</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Online capacity expansion (OCE)&lt;sup&gt;c&lt;/sup&gt;</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Online RAID level migration (ORLM)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Drive/disk roaming&lt;sup&gt;d&lt;/sup&gt;</td>
<td>Same-system support</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Between-systems support</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>RAIDXpert2 Web GUI (management GUI)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>rcadm (management CLUI)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Drive interfaces supported&lt;sup&gt;e&lt;/sup&gt;</td>
<td>SATA</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>SSD</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>ATAPI</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
18 Getting Started

a. At the AMD BIOS Configuration Utility (also referred to as the Option-ROM or O-ROM) arrays can be created or deleted, and Critical or Offline arrays are indicated. INT13 support can be turned off completely at the BIOS Configuration Utility.

b. See Arrays, Disks, and RAID Levels for detailed information about understanding arrays, RAID levels, and performance and reliability considerations.

c. The unique ability of RAIDXpert2 to provide online expansion to RAID levels across multiple disks becomes extremely valuable when expanded storage is a requirement.

d. Disk roaming allows arrays to be moved from port to port, either within the same system or between systems.

e. See the system’s motherboard specifications for the supported device interface.

f. Multiple RAID levels (array types) per disk allows the administrator to create different RAID levels on the same disks. For example: The administrator wants data redundancy for the user data, and creates a RAID5 set using part of the disks’ data. At the same time the administrator wants performance for the swap spaces, and creates a RAID0 array using the rest of the disks’ capacities (space). This feature is useful in collecting unused capacity from disks with different capacities.

g. This feature increases data integrity for redundant array types, by logging areas of an array that have been written to. In the event of a system crash, the logged area’s consistency is checked and/or corrected. Without this feature, data corruption might occur.

h. Arrays can be instantly created and used by skipping the background consistency check. For certain types of redundant arrays this is a viable option and has no data integrity drawbacks. A consistency check can always be done at a later time. If an initialization is skipped when using RAID5, the array is not redundant until a consistency check is performed.

i. Disks can be added to the system and to an array while the system is operating.

---

<table>
<thead>
<tr>
<th>Features</th>
<th>Sub-Features</th>
<th>License Levels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dissimilar disk support within the same array</td>
<td></td>
<td>RAIDXpert2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Basic</td>
</tr>
<tr>
<td>Cache support</td>
<td>No Cache</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Read Cache</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Write Back Cache</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Read with Write Back Cache</td>
<td>Yes</td>
</tr>
<tr>
<td>Create Array and Delete Array functions without rebooting</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Restore (rebuild) priority</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Multiple RAID levels per disk</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Touched region logging</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>E-mail event notification</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>System event log integration</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Instant create support</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Hot-swap support</td>
<td></td>
<td>Yes</td>
</tr>
</tbody>
</table>

---

Table 4  Feature set for RAIDXpert2: by RAIDXpert2 license level (continued)
### Understanding Arrays

Arrays are several disks that are grouped together to improve either the performance or reliability of a storage system. Because some RAID levels enhance performance while others improve reliability, it is important to consider the user’s needs when planning an array configuration.

**NOTE:** It is highly recommended that this user manual be reviewed in its entirety before configuring arrays. Some of the advanced features of RAIDXpert2 (such as sparing options) must be understood by the user before creating arrays.

### RAID Levels

RAIDXpert2 supports the RAID levels indicated in Table 5.

#### Table 5  RAID levels - general characteristics

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Main Characteristic</th>
<th>Use/Usefulness</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID0 (striping)</td>
<td>• Provides the highest performance but no data redundancy. Data in the array is</td>
<td>RAID0 arrays are useful for holding information, such as the operating system</td>
</tr>
<tr>
<td></td>
<td>striped (distributed) across several disks.</td>
<td>paging file, where performance is extremely important but redundancy is not.</td>
</tr>
<tr>
<td></td>
<td>• Supports 2-8 disks.</td>
<td></td>
</tr>
<tr>
<td>RAID1 (mirroring)</td>
<td>• Mirrors data on a partition of one disk to another.</td>
<td>Useful when there are only two disks available and data integrity is more</td>
</tr>
<tr>
<td></td>
<td>• Supports 2 disks.</td>
<td>important than storage capacity.</td>
</tr>
<tr>
<td>RAID5 (stripe with parity)</td>
<td>• Stripes data, as well as parity, across all disks in the array.</td>
<td>• Offers exceptional read performance, as well as redundancy.</td>
</tr>
<tr>
<td></td>
<td>• Parity information is interspersed across the disk array.</td>
<td>• Write performance is not an issue due to the tendency of operating systems to</td>
</tr>
<tr>
<td></td>
<td>• In the event of a failure, RAIDXpert2 can restore the lost data of the failed</td>
<td>perform many more reads than writes.</td>
</tr>
<tr>
<td></td>
<td>disk from the other surviving disks.</td>
<td>• Requires only one extra disk to offer redundancy.</td>
</tr>
<tr>
<td></td>
<td>• Supports 3-8 disks.</td>
<td>• For most systems with three or more disks this is the correct choice for a</td>
</tr>
<tr>
<td>RAID6 (stripe with parity)</td>
<td>• Stripes data, as well as dual parity, across all disks in the array</td>
<td>RAID level.</td>
</tr>
<tr>
<td></td>
<td>• Dual parity information is interspersed across the disk array.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• In the event of failure of 1 or 2 drives, RAIDXpert2 can restore the lost data of</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the failed disk(s) from the other surviving disks</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Supports 4-12 disks</td>
<td></td>
</tr>
<tr>
<td>RAID10 (striped RAID1 sets)</td>
<td>• Combines mirrors and stripe sets. RAIDXpert2 allows multiple disk failures, up</td>
<td>• Offers better performance than a simple mirror because of the extra disks.</td>
</tr>
<tr>
<td></td>
<td>to 1 failure in each mirror that has been striped.</td>
<td>• Requires twice the disk space of RAID1 to offer redundancy.</td>
</tr>
<tr>
<td></td>
<td>• Supports 4 disks.</td>
<td></td>
</tr>
</tbody>
</table>
### Array States

Within the management applications, an array is a logical device that can exist in one of three states: Normal, Critical, or Offline.

- In RAIDXpert2, these states display in the Array List section in a column named State.
- Within the `rcadm` Command Line tool, these states also display in a column named State.

The array states are defined in Table 6.

### Table 6  Array states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>The Normal state is displayed when everything is functioning correctly.</td>
</tr>
<tr>
<td>Ready</td>
<td>The Ready state is displayed while an array is being created.</td>
</tr>
<tr>
<td>Critical</td>
<td>The Critical state is displayed when the array is no longer redundant (fault tolerant) because of one or more disk failures. Arrays can still be read and written to, but the data is no longer protected should another disk fail.</td>
</tr>
<tr>
<td>Offline</td>
<td>The Offline state is displayed when arrays cannot be read or written to because of one or more disk failures.</td>
</tr>
</tbody>
</table>

Whether an array is marked as Critical or Offline depends upon what RAID level it is and how many disks within the array have failed. Note the changes in state in Table 7.

### Table 7  Failure states by RAID level

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>This Failure State...</th>
<th>Is Displayed Whenever...</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID1, RAID5 (redundant arrays)</td>
<td>Critical</td>
<td>A single disk fails.</td>
</tr>
<tr>
<td></td>
<td>Offline</td>
<td>Two or more disks fail.</td>
</tr>
<tr>
<td>RAID6 (redundant arrays)</td>
<td>Critical</td>
<td>One or two disks fail.</td>
</tr>
<tr>
<td></td>
<td>Offline</td>
<td>Three or more disks fail.</td>
</tr>
<tr>
<td>RAID10 (RAID levels with multiple redundancies)</td>
<td>Critical</td>
<td>A single disk fails in any one of the sets.</td>
</tr>
<tr>
<td></td>
<td>Offline</td>
<td>All disks in a set fail.</td>
</tr>
<tr>
<td>Volume and RAID0</td>
<td>Offline</td>
<td>A single disk fails.</td>
</tr>
</tbody>
</table>
More than one array can be created using the same set of disks. If a disk is disconnected that belongs to more than one array, only the arrays that try to access the disk and receive I/O errors report the failure. For example: there are two arrays, both of which are RAID5 sets, and both use disk 4. If a system being used by array 1 receives an I/O error when trying to communicate with disk 4, the state of array 1 changes to Critical. However, the state of array 2 using disk 4 does not change to Critical until an I/O error is reported. If systems using array 1 are not communicating with failed disk 4, the state of array 1 still displays as Normal.

If a rescan of all channels is performed after disconnecting a disk, the state of every array using the missing disk changes from Normal to either the Critical or Offline, depending on the RAID level.

See Rescanning Disks for Changes in State on page 23 for a discussion of when to rescan disks and the outcomes when doing so.

Creating Arrays: Future Expansion

When creating arrays, consider whether disk capacity needs to expand in the future. If the file system must be expanded, perform the tasks indicated in Table 8.

Table 8  Array expansion considerations

<table>
<thead>
<tr>
<th>For This Operating System</th>
<th>Do This...</th>
<th>And Consider This...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows®</td>
<td>Format the arrays with NTFS. Microsoft Corporation provides a utility (Diskpart.exe) that can dynamically extend an NTFS file system onto any unused adjacent space. Note also that using a single partition per array makes expansion much easier.</td>
<td>1. The Diskpart.exe utility version depends on which version of the Windows operating system is running. 2. The Diskpart.exe utility can be found on the CD for some versions of Windows operating systems, or on the Microsoft Corporation website (<a href="http://www.microsoft.com">http://www.microsoft.com</a>) for other versions. Use the correct version for the operating system.</td>
</tr>
<tr>
<td>Linux</td>
<td>Use an expandable file system.</td>
<td>Because RAIDXpert2 software is limited to eight arrays, if a large number of logical volumes are needed, use a logical volume manager (LVM).</td>
</tr>
</tbody>
</table>

Expanding Disk Capacity Online: Using OCE (supported by RAIDXpert2 Plus)

Online Capacity Expansion (OCE) allows:

- Adding disks to an array at any time to increase an array’s capacity.
- Accessing the array data while it is being redistributed.

To increase the size and organization of an array, transform the array. For more information about transforming arrays, see Transform Arrays (supported by RAIDXpert2 Plus) on page 54.

Migrating RAID Levels Online: Using ORLM (supported by RAIDXpert2 Plus)

Online RAID Level Migration (ORLM) allows an array to move from one RAID level to almost any other RAID level. This task includes migrating the array from a non-redundant RAID level to a redundant RAID level.

Prior to starting a RAID level migration/transformation, make sure that the disks selected for the destination array have sufficient capacity. RAID level migration/transformation can occur only when the destination array has the same or larger capacity as the source array.

While the migration/transformation is taking place, data is accessible and protected to the lowest protection of either the source RAID level or the destination RAID level.

The Transform task can also be used to expand the capacity of an array, by using OCE. It can also be used as part of the system backup and recovery strategy through the use of the RAID1 and RAID10 RAID levels.

To perform this process, see Transform Arrays (supported by RAIDXpert2 Plus) on page 54.
Array Tasks: Starting and Stopping Tasks

Tasks are started when one of the following actions are performed:

- Create a redundant array.
- Transform an array.
- Restore an array.
- Securely erase an array.
- Check for consistency on redundant arrays.
- Verify that data was not corrupted after a system crash (Check_Bitmap performed automatically).

Full task control can be used on Create, Consistency Check and Bitmap Check tasks. On a Transform or Restore task for dedicated and global spares, task control can only pause/resume, but it cannot remove the task. To remove these types of tasks, pause and then delete them.

**NOTE:** If a task is paused and then deleted, the array is also deleted. Deleting a task is the same as deleting an array; data loss occurs. Backup all data prior to deleting a task that involves a Transform or a Restore.

The tasks indicated in Table 9 can be displayed for each array.

**Table 9**  Types of tasks per array

<table>
<thead>
<tr>
<th>Task</th>
<th>When Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transform</td>
<td>While an array is being transformed.</td>
</tr>
<tr>
<td>Create</td>
<td>While an array is being created.</td>
</tr>
<tr>
<td>Consistency Check</td>
<td>While verifying that the parity (RAID5/RAID6) or mirror disk consistency is correct.  (For redundant type arrays only.)</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy allows users to make copies of an existing (source) array data to a new (destination) array.</td>
</tr>
<tr>
<td>Restore</td>
<td>While an array is being restored.</td>
</tr>
<tr>
<td>Secure Erase</td>
<td>While an array secure erase is being performed.</td>
</tr>
<tr>
<td>Check_Bitmap</td>
<td>While verifying that the parity on a RAID5/RAID6 set, or the mirror halves on a RAID1 or RAID10 set, are consistent. This action is performed automatically to ensure that data is not corrupted whenever a system crashes.</td>
</tr>
<tr>
<td>Not_Active</td>
<td>When no other tasks are being performed.</td>
</tr>
</tbody>
</table>

Understanding Disks

Disks States

Within the management applications, a disk can be part of one or more arrays and can exist in one of three states: Online, Offline, or SMART Error.

- In RAIDXpert2, these states are displayed in the Disk List section in a column named State. See Table 16 on page 47 for additional information.
- Within the rcadm program, these states are also displayed in a column named State. See Table 41 on page 80 and Table 42 on page 81 for additional information.

The disk states are defined in Table 10.
If a disk fails it is displayed in the Disk List as Online until a rescan is performed. (If host I/O is going to a failed disk and the disk is used in a single array, the disk appears as Online in the Disk List but is highlighted in red; the disk appears as Failed in Array View. If host I/O is going to a failed disk and the disk is used in multiple arrays, the disk may appear in the Disk List as Offline and as Failed for each array in Array View. After a rescan the Disk List state may change to Online).

After a rescan is performed the following can occur:

- A disconnected disk no longer appears in the Disk List (although the disk appears as Missing in the Array View for the arrays to which it belonged).
- A disk that experiences a catastrophic failure appears in the Disk List as Offline and is highlighted in red. The disk appears as Failed for the arrays to which it belonged.
- A disk that has a SMART error appears in the Disk List as SMART Error. (A disk with a SMART error can be used to create an array, but the array must be created in the BIOS Configuration Utility, not in RAIDXpert2.)
- A disk that experiences a software-related failure appears in the Disk List as Online and is highlighted in red. New arrays can be created with the disk.

Arrays that exist on a failed or disconnected disk might not be designated as Failed or Missing until the system attempts to communicate with the failed or disconnected disk.

## Rescanning Disks for Changes in State

The information displayed in the Disk List section is the state of the disks when they were last scanned. If a rescan has not been performed, the information being displayed is the state of the disks at boot time.

Every time a disk is connected or disconnected while online, a message asks if the user wants to perform a rescan (of all SATA channels). If Rescan is selected, the information in both the Array List and the Disk List is updated. This view might show arrays as being in a Critical or Offline state, if all disks have not been installed or removed.

Although it is highly recommended that the system be shut down before adding or removing disks, disks can be added or removed while the system is online (“hot-swapping”), if the system supports the hot-swapping function. Because of this function, RAIDXpert2 does not automatically perform a rescan when it detects that a disk has been added or removed. For example, to hot-swap a RAID5 set with six disks into a new system, do not perform a rescan until all six disks have been connected.

Arrays associated with the disks that are not yet connected change state to either Critical or Offline. In the example above, if the state of the RAID5 set changes to Offline, data is lost.

Rescanning can also result in the state of a disk being reported differently in the Array View and the Disk List. A disk within an array can have a state of Failed in the Array View field, while at the same time it can show a state of Online in the Disk List.

### Table 10  Disk states

<table>
<thead>
<tr>
<th>Disk State</th>
<th>When Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online</td>
<td>Whenever the disk is connected, functioning correctly, and RAIDXpert2 can communicate with it.</td>
</tr>
<tr>
<td>New</td>
<td>Whenever an uninitialized, new disk is connected.</td>
</tr>
<tr>
<td>Legacy</td>
<td>Whenever a disk containing non-RAIDXpert2 configuration data is connected.</td>
</tr>
<tr>
<td>Offline</td>
<td>Whenever the disk fails and RAIDXpert2 detects an error condition on the disk.</td>
</tr>
<tr>
<td>SMART Error</td>
<td>Whenever the disk reports a SMART error(s) to RAIDXpert2.</td>
</tr>
</tbody>
</table>

If a disk fails it is displayed in the Disk List as Online until a rescan is performed. (If host I/O is going to a failed disk and the disk is used in a single array, the disk appears as Online in the Disk List but is highlighted in red; the disk appears as Failed in Array View. If host I/O is going to a failed disk and the disk is used in multiple arrays, the disk may appear in the Disk List as Offline and as Failed for each array in Array View. After a rescan the Disk List state may change to Online).

After a rescan is performed the following can occur:

- A disconnected disk no longer appears in the Disk List (although the disk appears as Missing in the Array View for the arrays to which it belonged).
- A disk that experiences a catastrophic failure appears in the Disk List as Offline and is highlighted in red. The disk appears as Failed for the arrays to which it belonged.
- A disk that has a SMART error appears in the Disk List as SMART Error. (A disk with a SMART error can be used to create an array, but the array must be created in the BIOS Configuration Utility, not in RAIDXpert2.)
- A disk that experiences a software-related failure appears in the Disk List as Online and is highlighted in red. New arrays can be created with the disk.

Arrays that exist on a failed or disconnected disk might not be designated as Failed or Missing until the system attempts to communicate with the failed or disconnected disk.

## Rescanning Disks for Changes in State

The information displayed in the Disk List section is the state of the disks when they were last scanned. If a rescan has not been performed, the information being displayed is the state of the disks at boot time.

Every time a disk is connected or disconnected while online, a message asks if the user wants to perform a rescan (of all SATA channels). If Rescan is selected, the information in both the Array List and the Disk List is updated. This view might show arrays as being in a Critical or Offline state, if all disks have not been installed or removed.

Although it is highly recommended that the system be shut down before adding or removing disks, disks can be added or removed while the system is online (“hot-swapping”), if the system supports the hot-swapping function. Because of this function, RAIDXpert2 does not automatically perform a rescan when it detects that a disk has been added or removed. For example, to hot-swap a RAID5 set with six disks into a new system, do not perform a rescan until all six disks have been connected.

Arrays associated with the disks that are not yet connected change state to either Critical or Offline. In the example above, if the state of the RAID5 set changes to Offline, data is lost.

Rescanning can also result in the state of a disk being reported differently in the Array View and the Disk List. A disk within an array can have a state of Failed in the Array View field, while at the same time it can show a state of Online in the Disk List.
Sparing Options: Disks and Arrays

RAIDXpert2 supports multiple sparing options. Spares are restored in the order indicated in Table 11.

### Table 11  Sparing options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dedicated</td>
<td>A spare disk assigned to a specific redundant array.</td>
</tr>
<tr>
<td>Global</td>
<td>A spare disk that is shared by multiple arrays.</td>
</tr>
</tbody>
</table>

**NOTE:** An array is marked Critical or Offline if a disk reports a Failed state to an I/O, or if the SATA cable or power cable is disconnected.

**NOTE:** One or more spares can be assigned to a redundant RAID level.

**NOTE:** Spare assignments do not apply to non-redundant RAID levels. To protect data, transform the array to a redundant RAID level. Spares can then be assigned. (Be aware that the Transform task is supported only by RAIDXpert2 Plus, RAIDXpert2 VTS, and RAIDXpert2 VTS Plus.)

#### Dedicated Sparing

A dedicated spare is a disk that is assigned as an alternate disk for a specific array. Should a disk fail in that array, the alternate disk is used to replace the failed disk and the array is rebuilt.

A dedicated spare can be assigned to any redundant array type, and up to four spares can be assigned to an array.

**CAUTION:** Assigning a dedicated spare does not reserve space on the disk. Therefore, an automatic restore is not guaranteed if a disk fails. If a disk fails, make space on the disk for the fail-over to complete, or assign a different disk with enough space. If a dedicated spare is assigned and a disk fails, the restore process starts automatically, if there is enough space available on the dedicated spare.

For additional information, see Add or Remove Dedicated Spares on page 61.

#### Global Sparing

A global spare is a disk that is assigned as an alternate disk for multiple arrays, instead of associating it with only one array.

Many arrays can be restored using the global spare disk, as long as it is not already part of the array and it has enough space available. Unlike a dedicated spare, this type of spare can be assigned at any time, even while tasks are running on arrays.

Assigning a disk for use as a global spare does not reserve space on that disk. An automatic restore is not guaranteed if a disk fails.

If there is not enough disk space on the global spare, make room for the fail-over to complete, or assign a different disk with enough capacity as the spare. If there is enough space available on the global spare and a disk failure occurs, the restore process starts automatically.

For additional information, see Add or Remove Global Spares on page 61.
RAID Performance Considerations

With RAID technology, performance is based on the following considerations:

- The number and organization of disks in an array.
- Caching attributes used for the array.
- Application workload.

Number and Organization of Disks

RAID functions increase performance by putting more disks to work and by buffering data for the host.

Many disks can transfer data at greater than 50 MB per second. RAIDXpert2 can aggregate this bandwidth in an almost linear fashion, as more of the same disks are included in an array.

Caching Attributes

RAIDXpert2 can also be configured to provide read and Write Back caching, if desired. Write Back caching has a large effect on most workloads, but should be used with caution.

Application Workload

When configuring an array, workload is probably the most important performance variable. Most applications do many more reads than writes. The best performance is obtained with array types like RAID0, RAID5, RAID6, or RAID10.

RAID Reliability Considerations

RAID reliability is enhanced through data redundancy and backup.

Data Redundancy

RAID1, RAID5, RAID6, or RAID10 are necessary for redundancy. With redundancy, both capacity and performance are sacrificed for reliability. With RAIDXpert2, extremely high performance is obtained even with redundant-type arrays.

Backup

The ability of RAIDXpert2 to transform arrays can be used as part of a backup strategy.

As part of a “hot fallback” strategy, the backup array can be kept online and hidden from the operating system or remain visible, or it can be removed from the system and stored as a backup device.

NOTE: The Transform task is supported by RAIDXpert2 Plus.

Flexibility and Expansion Considerations

Before configuring an array, consider the following points to enhance the flexibility of the RAID system.

Multiple RAID Levels

With RAIDXpert2, different RAID levels can be created on the same disk, to adapt each array to the I/O that it processes. Also, more than one array can be created per disk.

Depending on the array capacity and redundancy level, an existing array can be transformed to another RAID level, if the level of the array being used is not the optimal RAID level for the application. Also, different arrays with different characteristics can be built for different applications.
RAIDABLE Arrays

RAIDABLE arrays are a special type of JBOD that allow the user to add more storage space or create a redundant array after a system is installed. RAIDABLE arrays are created using OpROM, UEFI, or rcadm.

**NOTE:** The ability to create RAIDABLE arrays may not be available on your system.
When to Use the AMD-RAID Controller BIOS Configuration Utility

The AMD-RAID Controller BIOS Configuration Utility is also known as the Option ROM (O-ROM). Use the utility to accomplish the procedures indicated in Table 12.

**Table 12** When to use the AMD-RAID Controller BIOS Configuration Utility (Option ROM)

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Description</th>
<th>Find Information At...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initialize a new disk</td>
<td>To initialize a new disk drive for data storage.</td>
<td>Initialize Disks on page 28.</td>
</tr>
<tr>
<td>Create or delete arrays</td>
<td>Create arrays at different RAID levels (depending on the license level for the system), or delete an array.</td>
<td>Create Arrays on page 28. Delete Arrays on page 30.</td>
</tr>
<tr>
<td>Swap arrays</td>
<td>Change the array order, especially for the AMD-RAID bootable array.</td>
<td>Swap Arrays on page 30.</td>
</tr>
<tr>
<td>Manage hot spares</td>
<td>Allows selection of global and dedicated hot spares.</td>
<td>Manage Spares on page 31.</td>
</tr>
<tr>
<td>View disk and array details</td>
<td>View information about each disk or array.</td>
<td>View Disk Details on page 32. View Array Details on page 32.</td>
</tr>
<tr>
<td>Rescan all channels</td>
<td>Rescan all channels to detect new or removed disks and arrays.</td>
<td>Rescan All Channels on page 32.</td>
</tr>
<tr>
<td>Change controller options</td>
<td>Change INT13 boot support, turn off Critical arrays or warning for Offline arrays while booting, or change the number of disks that can be spun-up when the system is powered-on.</td>
<td>Change the Controller Options on page 32.</td>
</tr>
<tr>
<td>Continue to boot</td>
<td>Exit the BIOS Configuration Utility and continue booting the system.</td>
<td>Continue Booting from the BIOS Configuration Utility on page 33.</td>
</tr>
</tbody>
</table>

Access the AMD-RAID Controller BIOS Configuration Utility

When booting the system, press Ctrl + R when the BIOS banner displays. There is a maximum of three seconds to use this key combination to enter the BIOS Configuration Utility.

**NOTE:** If the BIOS Configuration Utility does not display, contact your system or motherboard supplier.

Understanding the Color Code in the BIOS Configuration Utility

Color codes indicate the type or status of information at the BIOS Configuration Utility. See the table below.

**Table 13** BIOS Configuration Utility color codes

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>White text</td>
<td>Indicates an available option or informational text.</td>
</tr>
<tr>
<td>Black text, yellow highlighting</td>
<td>Indicates an option or device for which action might be taken.</td>
</tr>
<tr>
<td>Yellow text</td>
<td>Indicates information about the yellow-highlighted option.</td>
</tr>
<tr>
<td>Green text</td>
<td>Indicates an item that has been selected.</td>
</tr>
<tr>
<td>Light blue text</td>
<td>Indicates that the item cannot be selected.</td>
</tr>
</tbody>
</table>
Initialize Disks

New disks and legacy disks must be initialized before they can be used to create an AMD-RAID array.

Initialization writes AMD-RAID configuration information (metadata) to a disk.

1. At the Main Menu, use the arrow keys to highlight Initialize Disk(s).
2. Press Enter to select Initialize Disk(s).
3. Select the disks to initialize:
   • To select all disks, press the A key.
   • To select individual disks, highlight a disk with the arrow keys and press Insert. Any number of disks may be selected using this method.
4. Press Enter to initialize the selected disks.
5. Press the C key to confirm the initialization
   Alternatively, press Esc to cancel the initialization.

Initialization takes 10–15 seconds per disk. During initialization, a status indicator shows which disk is being initialized. When the initialization is complete, the status indicator turns off. A complete rescan of all channels is done automatically during initialization.

Create Arrays

Arrays can be created after the disks are initialized. See RAID Levels on page 19, for deciding what type of RAID levels to use for the array.

TIP: See also Create and Format Arrays on page 52, and Create New Arrays: rcadm --create on page 82.

Before you begin...

• In some circumstances, more than eight arrays are possible. They might appear to function properly, but are not supported by AMD-RAID.
• For redundant arrays, the Create process is not finished until after the operating system and AMD-RAID OS drivers have been installed and the system has booted to the operating system. However, the arrays are immediately available to use for either a bootable array or a data array.
• Array numbers are valid only for a given boot, and might be different in the BIOS Configuration Utility and RAIDXpert2. If a permanent label is required, use the Array Naming feature.
• At any point in the procedure, return to a prior window by pressing Esc.
• If the system is booted from an AMD-RAID bootable array, the first array in the Arrays section must be the bootable array. The system boots only from the first array in the Arrays section. As necessary, use the Swap Two Arrays feature to swap arrays and place the RAIDxpert2 bootable array in the first position.

Create An Array

NOTE: The ability to create RAID10 arrays may not be available on your system.

1. At the Main Menu, use the arrow keys to highlight Create Array.
2. Press Enter.
3. Select the disks with which to create the array:
   • To select all disks, press the A key.
   • To select individual disks, highlight a disk with the arrow keys and press Insert. Any number of disks may be selected using this method.
4. Press Enter to include the selected disks in the array.
5. In the User Input section, use the arrow keys to select an array type. Only array types that can be created with the selected disks are available.
6. Press Enter.
7. Select an array size.
   To create an array whose size is less than or equal to 2.199 TB:
   a. Press the Page Up or the up arrow key to increase the array size and the Page Down or down arrow key to decrease the size.
   b. Press Enter when the desired size is reached.
   To create an array whose size is greater than 2.199 TB:
   a. Press the Page Up or the up arrow key to increase the array size and the Page Down or down arrow key to decrease the size.
   b. When an array size of 2.199 TB is reached, a message states that a size greater than the maximum is being attempted, and whether the size of the array should be limited.
   c. Press Esc to create an array larger than 2.199 TB.
   d. Press the Page Up/Page Down or the up/down arrow keys to continue modifying the size.
   e. Press Enter when either the desired size or the maximum available size is reached.
8. Select a caching level using the arrow keys.
10. Press C to confirm the array settings.
    Alternatively, press Esc to go back to a previous page or M to exit to the Main Menu.
11. Repeat step 3 through step 10 to create additional arrays.

When installing the operating system to an AMD-RAID bootable array, modify the boot priority list in the motherboard BIOS. See the motherboard’s user documentation for more information. Ensure that the AMD-RAID bootable array is included in the boot priority list.

Ensure that INT13 support is enabled on the RAID controller, as described in Change the Controller Options on page 32.

Create an AMD-RAID Bootable Array

⚠️ CAUTION: Do not use eSATA drives for bootable arrays as they are removable.

The operating system and RAIDxpert2 files can be installed to a RAIDxpert2 bootable array. Use the Create An Array procedure above to create the bootable array. Ensure it is the first array listed in the Arrays section of the BIOS Configuration Utility.

To install the operating system and RAIDxpert2 files see Software Installation.
Create a RAIDABLE Array

**NOTE:** The ability to create RAIDABLE arrays may not be available on your system.

1. At the **Main Menu**, use the arrow keys to highlight **Create Array**.
2. Press **Enter**.
3. Select the disk with which to create the array:
4. Press **Enter** to include the selected disk in the array.
5. In the User Input section, use the arrow keys to select **RAIDABLE**.
6. Press **Enter**.
7. Press **C** to confirm the array settings.
   Alternatively, press **Esc** to go back to a previous page or **M** to exit to the **Main Menu**.

Delete Arrays

△ **CAUTION:** Deleting an array permanently destroys all data that is on the array. This action cannot be undone and it is very unlikely the data can be recovered.

△ **CAUTION:** Do not delete the first array listed in the Arrays section, if it is the AMD-RAID bootable array. Doing this deletes the operating system and AMD-RAID files.

Delete an Array

1. At the **Main Menu**, use the arrow keys to highlight **Delete Arrays**.
2. Press **Enter**.
3. Select the arrays to delete:
   • To select all arrays, press the **A** key.
   • To select individual arrays, highlight an array with the arrow keys and press **Insert**. Any number of arrays may be selected using this method.
4. Press **Enter** to delete the selected arrays.
5. Press **C** to confirm the deletion.
   Alternatively, press **Esc** to exit to the **Main Menu**.

⚠ **TIP:** Also see **Delete Arrays** on page 57.

Swap Arrays

Use the Swap Two Arrays option to arrange arrays in a different order.

Before you begin...

• If more than one array is created, install the operating system to any of them. However, a small amount of boot information is always written to a disk(s) in the first array (Array 1) of the Array section, regardless on which array the operating system is installed. If anything happens to a disk in Array 1, the system might not be able to boot. It is recommended that the user install the operating system on an AMD-RAID bootable array at a redundant RAID level—such as RAID1 or RAID5—and swap the array into the first position, if it is not already Array 1.
• Swapping arrays can be performed only at the BIOS Configuration Utility.
Swap Arrays

1. At the **Main Menu**, use the arrow keys to highlight **Swap Two Arrays**.
2. Press **Enter**.
3. Select the arrays to swap:
   a. Highlight an array using the arrow keys.
   b. Press **Insert** to select it.
   c. Highlight a different array using the arrow keys.
   d. Press **Insert** to select it.
4. Press **Enter** to swap the arrays.

Manage Spares

This option allows the user to assign or unassign global or dedicated spares.

Assign Global Spares

1. At the **Main Menu**, use the arrow keys to highlight **Manage Host Spare(s)**.
2. Press **Enter**.
3. Use the arrow keys to highlight **Assign Global Hot Spare(s)**.
4. Press **Enter**.
5. Select the disks to assign as global spares:
   • To select all disks, press the **A** key.
   • To select individual disks, highlight a disk with the arrow keys and press **Insert**. Any number of disks may be selected using this method.
6. Press **Enter** to assign the selected disks as global spares.

Assign Dedicated Spares

1. At the **Main Menu**, use the arrow keys to highlight **Manage Host Spare(s)**.
2. Press **Enter**.
3. Use the arrow keys to highlight **Assign Dedicated Hot Spare(s)**.
4. Press **Enter**.
5. Use the arrow keys to highlight the array.
6. Press **Enter**.
7. Select the disks to assign as dedicated spares.
   • To select all disks, press the **A** key.
   • To select individual disks, use the arrow keys to highlight the disk and press **Insert** to select it. Any number of disks may be selected using this method.
8. Press **Enter**.
9. Press **C** to continue.
   Alternatively, press **Esc** to exit to the **Main Menu**.

Unassign Spares

1. At the **Main Menu**, use the arrow keys to highlight **Manage Host Spare(s)**.
2. Press **Enter**.
3. Use the arrow keys to highlight **Unassign Hot Spare(s)**.
4. Press **Enter**.
5. Select the disks to unassign as spares:
   • To select all disks, press the **A** key.
   • To select individual disks, use the arrow keys to highlight the disk and press **Insert** to select it. Any number of disks may be selected using this method.
6. Press Enter to unassign the selected disks.
7. Press C to continue.
   Alternatively, press Esc to exit to the Main Menu.

**View Disk Details**

This option allows the user to view details about the disk. Nothing can be changed using this menu option; it is for informational purposes only.

1. At the **Main Menu**, use the arrow keys to highlight View Disk Details.
2. Press Enter.
3. Use the arrow keys to highlight a disk. Information about the disk is displayed in the Information field across the top:
   - Unique Disk ID
   - Drive Type
   - Cache Settings
   - Maximum Free Space
   - Model Number
   - Serial Number
4. Press Esc to exit to the Main Menu.

**View Array Details**

This option allows the details of the array to be viewed. Nothing can be changed using this menu option; it is for informational purposes only.

1. At the **Main Menu**, use the arrow keys to highlight View Array Details.
2. Press Enter.
3. Use the arrow keys to choose an array.
4. The full details of the array are displayed in the Information field across the top:
   - Array number
   - RAID level
   - Size
   - State
   - Cache settings

NOTE: The disks in the array are selected (green).

**Rescan All Channels**

This option allows the user to rescan all channels to detect new or removed disks and arrays. It rereads the configuration information from each disk.

Sometimes when a disk is offline, it can be brought online through a rescan.

1. At the **Main Menu**, use the arrow keys to highlight Rescan All Channels.
2. Press Enter.
   The activity indicator in the Information field spins while the disks are being polled.

**Change the Controller Options**

Controller Options allows the user to configure options for the boot sequence.

NOTE: By default, all options are On. It is recommended that options remain On.
Booting the system from an array

This option allows the user to enable boot support.

It is recommended that this option be disabled only if the system is booted from another device.

1. At the Main Menu, use the arrow keys to highlight Controller Options.
2. Press Enter.
3. Use the arrow keys to highlight Toggle INT13 Boot Support.
4. Press Enter to toggle between On and Off.
5. Press Esc to return to the Main Menu.

Pausing the boot sequence for warning messages

When the Pause feature is enabled and an array goes critical, offline, or there is another problem with the system, the boot process stops and an error message is displayed on the screen. The user must press Enter to continue booting.

If the Pause feature is disabled, error messages are displayed briefly, but the system continues to boot.

1. At the Main Menu, use the arrow keys to highlight Controller Options.
2. Press Enter.
3. Set pauses to the boot sequence for critical warnings.
   a. Use the arrow keys to highlight Toggle Pause if Critical.
   b. Press Enter to toggle between On and Off.
      • On enables pauses.
      • Off disables pauses
4. Set pauses to the boot sequence for offline warnings.
   a. Use the arrow keys to highlight Toggle Pause if Offline.
   b. Press Enter to toggle between On and Off.
      • On enables pauses.
      • Off disables pauses
5. Press Esc to return to the Main Menu.

Change the Staggered Spinup Count

Depending on a system’s power supply load-rating, the end-user might want to limit the number of disks that are spun-up together when a system is powered on.

For example, if a system has six disks and the staggered spinup count is set to 2, RAIDXpert2 sends a command to spin-up disks 1 and 2 together, then disks 3 and 4, and finally disks 5 and 6.

1. At the Main Menu, use the arrow keys to highlight Controller Options.
2. Press Enter.
3. Use the arrow keys to highlight Set Staggered Spinup Count.
4. Press Enter.
   The number within the brackets changes color to indicate it is selected.
5. Use the arrow keys to change the number within the brackets. The minimum is 1 and the maximum is 8.
6. Press Enter to save the setting.
7. Press Esc to return to the Main Menu.

Continue Booting from the BIOS Configuration Utility

After settings have been changed, continue booting the system from the point where the user entered the RAIDXpert2 BIOS Configuration Utility.

Resume the Boot Process

1. At the Main Menu, use the arrow keys to highlight Continue to Boot.
2. Press Enter.
Software Installation

This Installation Guide is designed to assist you with system setup, by performing these general procedures:

System setup process overview

A generic system setup process follows these steps:

1. Copy the AMD-RAID drivers to a removable storage medium.

   **IMPORTANT:** Install the device drivers and applications on a system at the same time that the Windows or Linux operating system is installed.

2. Power-on the system.
3. Access the platform BIOS setup for the system. For supported AMD chipsets, set the SATA mode as RAID. (This enables the loading of the AMD-RAID Option-ROM).
4. Initialize the disks, using the AMD-RAID Array Configuration Utility.
5. Create arrays, using the AMD-RAID Array Configuration Utility.
6. Install the AMD-RAID drivers on the system.
7. Load the operating system.
8. Install the OS RAID Management Suite (AMD RAIDXpert2) on the system.

**NOTE:** To protect your data, always perform a backup prior to installing any new, major hardware or software.

Before you begin...

Have the Windows or Linux operating system software available and ready to install.

Copying AMD-RAID drivers to removable storage

You need to copy the drivers to a removable storage medium before you begin the installation.

Copying AMD-RAID drivers in a Microsoft Windows environment

1. Power on the system.
2. Locate and use a system that is running a Windows operating system and has a CD DVD drive, floppy disk drive, or an I/O port for removable storage media (such as a USB flash drive).
3. Go to a browser and access the web site of your system supplier or motherboard vendor.
4. Insert the storage medium into the system:
   - For Windows XP, insert a floppy disk into the disk drive.
   - For Windows Vista, Windows 7 or Windows 8, connect a USB flash drive to a USB I/O port, or insert a blank CD-DVD disk into the applicable drive.
5. Download the AMD-RAID drivers from the web site to the appropriate removable storage medium.

Copying AMD-RAID drivers in a Linux environment

1. Power on the system.
2. Locate and use a system that is running a Windows operating system and has a USB I/O port for the USB flash drive.
3. Use a browser to access the web site of your system supplier or motherboard vendor.
4. Insert a USB flash drive into the USB I/O port of the system.
5. Download the AMD-RAID drivers for the correct distribution version of Linux. Copy the drivers onto the USB flash drive:
   - For SUSE Linux: Copy the files contained inside the applicable `dd-rcraid-SLES1x-2.6.xx.xx-` folder to the USB flash drive. The following files should be located on the USB flash drive for a SUSE Linux Enterprise Desktop (SLED) installation. For example:
     - `linux` folder
     - `common_shell`
     - `install`
     - `LICENSE`
     - `Uninstall`
   - For Ubuntu Linux: Copy the files contained inside the `dd-rcraid-Ubuntu12-3.w.x-xyz-` folder into a `dd` directory located on a USB flash drive. For an Ubuntu Linux Desktop Server installation the following files should be located in the `dd` directory located on the USB flash drive `root`. For example:
     - `dd`
       - `load_raidcore`
       - `post_install`
       - `post_install2`
       - `pre_install`
       - `rcraid.ko`
       - `rcraid_generic.ko`
       - `readme`

**Pre-installation steps**

You can choose to boot from the platform BIOS (Basic Input-Output System) or from UEFI. UEFI is a recent industry to standardize boot procedures which, until recently, have been platform-specific.

**BIOS Mode**

1. Power on the system.
2. In the BIOS setup, set or configure the SATA Mode to RAID.
3. In the BIOS setup, set or configure the Boot mode to Legacy.
4. Make sure that the AMD-RAID bootable array is included in the system's boot priority list.
5. At the system's **Power-On Self-Test (POST)** screen, press **Ctrl + R** to access the AMD-RAID Array Configuration Utility (aka Option-ROM or O-ROM).
6. Scroll to Controller Options. Make sure that INT13 Boot Support is ON for AMD-RAID.
7. If more than one array exists at the **AMD-RAID Array Configuration Utility**, make sure that the desired bootable array is the first array listed in the Arrays list. Use the Swap Two Arrays task to place the bootable array first.

**UEFI Mode**

1. Power-on the system.
2. In the BIOS setup, set or configure the SATA Mode to RAID.
3. In the BIOS setup, set or configure the UEFI Boot to Enable.
4. In the BIOS setup, set or configure the SATA supporting as to UEFI Mode.
5. At the system's **Power-On Self-Test (POST)** screen, press **F7 / F12 / ESC** (or similar) to access the UEFI Configuration Utility (aka UEFI Boot Manager).
6. Boot to the EFI Internal shell
7. Enter `fsx:x`, where `x` is the number of the UEFI Flash Drive.
8. Use `rcadm` to create the desired Boot Virtual Disk.
Installing AMD-RAID drivers

Follow the procedures below for your Microsoft Windows or Linux installation.

Installing AMD-RAID drivers while installing Microsoft Windows

NOTE: The windows described in this guide are typical. Path names and text can vary, depending on user-designated selections and other parameters.

Installing AMD-RAID drivers during a Microsoft Windows XP installation

1. Power on the system.

NOTE: Do not boot up with a USB flash key in the system when performing an install, as the system will use that as the boot device.

2. Create a bootable array by following the procedure in Create Arrays on page 28.

3. Insert the Microsoft Windows operating system CD-ROM or DVD into the system’s CD or DVD drive.

4. Boot the system and allow it to access the Microsoft Windows operating system CD-ROM or DVD.

NOTE: For Windows XP, press F6 immediately.

5. At the applicable Windows setup window, perform the following steps:
   - For Windows XP 32-bit SP3:
     - Press F6 to install the drivers.
     - At the driver selection window, press S to select a third-party driver.
     - Browse to the location of the driver and press Enter.
   - Follow the on-screen instructions to complete the installation of the applicable Windows operating system.

7. After the OS is installed, open Device Manager.
   a. At Other Devices, right-click on AMD Configuration Device.
   b. Select Update driver software.
   c. Select Browse and navigate to the storage medium.
   d. Click OK.
   e. Click Next.
   f. If the Windows Security pop-up menu appears, click Install (or similar).
   g. Click Close.

8. Reboot the system.

9. After the OS has booted up, see Windows: Install the AMD RAIDXpert2 Management Suite.

10. Remove the storage medium and Microsoft Windows OS CD-ROM or DVD from the applicable drive(s) and port.

Installing the AMD-RAID drivers during a Microsoft Windows Vista, Windows 7 or Windows 8 installation

1. Power on the system.

NOTE: Do not boot up with a USB flash key in the system when performing an install, as the system will use that as the boot device.

2. Create a bootable array by following the procedure in Create Arrays on page 28.

3. Insert the Microsoft Windows operating system CD-ROM or DVD into the system's CD or DVD drive.

4. Boot the system and allow it to access the Microsoft Windows operating system CD-ROM or DVD.
5. At the applicable Windows setup window, perform the following:
   a. Insert the storage medium with the AMD-RAID drivers into the USB port or applicable system drive.
   b. Enter the requested information at the **Install Windows** window.
   c. At the **Load Driver** window, click **Browse**.
   d. Locate and select the applicable driver and then click **OK**.
   e. At the **Select the driver to be installed** window, review the selected driver; if correct, click **Next**.
6. Follow the on-screen instructions to complete the installation of the applicable Windows operating system.
7. After the OS is installed, open Device Manager.
   a. At **Other Devices**, right-click on **AMD Configuration Device**
   b. Select Update driver software.
   c. Select **Browse** and navigate to the storage medium.
   d. Click **OK**.
   e. Click **Next**.
   f. If the Windows Security Pop up appears, click **Install** (or similar).
   g. Click **Close**.
8. Reboot the system.
9. After the operating system is installed, remove the storage medium and Microsoft Windows OS CD-ROM or DVD from the applicable drive(s) and port.
10. Proceed to **Installing the AMD RAIDXpert2 Management Suite for Microsoft Windows** on page 41.

**Installing AMD-RAID drivers while installing Linux**

**NOTE:** The Linux operating system modules must include the **gcc+** compiler and the **pthreads** library, so that the **rcadm** program can be installed properly.

There are separate procedures in this section for each supported version of Linux:
- For SUSE Linux 10.x and 11.x installations, see **Installing the AMD-RAID drivers during a SUSE Linux Enterprise Desktop (SLED) Installation** on page 38.
- For Ubuntu Linux 12.x Desktop installations, see **Installing the AMD-RAID drivers during a Ubuntu 12.x Desktop Linux installation** on page 40.

**Installing the AMD-RAID drivers during a SUSE Linux Enterprise Desktop (SLED) Installation**

**NOTE:** Prior to starting this procedure, obtain the AMD-RAID drivers from your system supplier or motherboard vendor. Copy the AMD-RAID drivers to a USB flash drive, following the instructions in **Copying AMD-RAID drivers in a Linux environment** on page 35.

**NOTE:** The SUSE driver CD-ROM **.iso** image contains all Linux variations (**smp**, **bigsmp**, etc.) for a particular release. Therefore, only one **.iso** file exists.

**NOTE:** Some of the windows indicated in this procedure might not appear during the installation.

1. Power on the system.
2. Insert the USB drive that contains the AMD-RAID drivers into the USB port.
3. Insert the SUSE Linux operating system CD-ROM or DVD into the system’s CD or DVD drive.
4. Create a bootable array by following the procedure in **Create Arrays on page 28**.
5. At the **SUSE Linux Enterprise Desktop** window, scroll down to Installation.
   a. At **Boot Options**, type: `brokenmodules=ahci oem-modules=1`
   b. At SLED 10 SP4 32-bit, type: `brokenmodules=ahci oem-modules=1 irqpoll`

   **IMPORTANT:** Type in the command line within 3 to 5 seconds after the window appears.

   c. Press Enter.

   **NOTE:** It might be necessary to press F3, to change the Video Mode to VESA, if no video appears on the monitor.

6. At the **Language** window:
   a. Select **I Agree to the License Terms**.
   b. Make sure that the Language and Keyboard Layout categories are set to English (US), or select a different language.
   c. Click Next.

7. At the **Media Check** window, make sure that the CD or DVD Drive setting is correct and click Next.

8. At the **Installation Mode** window, make sure that **New Installation (default)** is selected and click Next.

9. At the **Clock and Time Zone** window:
   a. Select the desired **Region** and **Time Zone**.
   b. Ensure that the **Hardware Clock Set to UTC** checkbox is not selected if local time is desired.
   c. Click Next.

10. At the **Server Base Scenario** window:
    a. Ensure that **Physical Machine (default)** is selected.
    b. Select any other settings that are appropriate for your configuration.
    c. Click Next.

11. At the **Installation Settings** window:
    a. Click the **Overview** tab.
    b. Click the **Software** category.
    c. At the **Development** category, select the **C/C++ Compiler and Tools** checkbox.
    d. Click the **Details...** button.
    e. At the **Filter** drop-down menu, select **Search**.
    f. At **Search**, type `libstdc++` and click **Search**.
    g. At the checkboxes that appear on the right-hand section of the window, ensure that the checkboxes that correspond to the 32-bit standard C++ shared libraries are selected, and click **Accept**.
    h. At the **YaST2 agfa-fonts** window, click **Accept**.
    i. At the **Changed Packages** window, click **Continue**.

12. At the **Installation Settings** window:
    a. Click the **Overview** tab.
    b. Click the **Partitioning** category.
    c. At the **Preparing Hard Disk: Step 1** window, select the AMD Array and click Next.
    d. At the **Preparing Hard Disk: Step 2** window, review the text and click Next.

13. Back at the **Installation Settings** window:
    e. Click the **Expert** tab.
    f. Click the **Booting** category.
    g. Click the **Boot Loader Installation** tab.
    h. Change the setting from Boot from Boot Partition to Boot from Master Boot Record and click **OK**.
    i. At the main menu of the **Installation Settings** window, verify that the settings are correct and click **Install**.

14. At the **YaST2 Confirm Installation** window, review the text and click **Install**.

15. Wait while the Perform Installation process runs and then reboot the system when prompted.
16. When the installation is finished remove the USB flash drive and the SUSE Linux operating system CD or DVD from the system and reboot the system.

17. At the **Password for the System Administrator** `root`:
   a. Type the applicable root password.
   b. Re-type the root password.
   c. Click **Next**.

18. Enter a Hostname, enter a Domain Name, and then click **Next**.

19. At **Network Config** (configure all that apply):
   a. Setup General Network Settings
   b. Setup Firewall
   c. Setup Network Interface(s)
   d. Setup ISDN Adapter
   e. Setup Modems
   f. Setup VNC Remote Administration
   g. Setup Proxy
   h. Click **Next**.
      i. At the **Test Internet Connection**, select an option and then click **Next**.

20. At **Installation Overview**, setup **Ca Management** and then click **Next**.

21. Setup User Authentication Method and then click **Next**.

22. Setup New Local User, and then click **Next**.

23. Review Release Notes, and then click **Next**.

24. At the **Hardware Configuration** (configure all that apply):
   a. Setup Graphic Card
   b. Setup Printer
   c. Setup Sound
   d. Click **Next**.

25. At the **Installation Complete**, select / unselect **Clone This System**, and then click **Finish**.

26. Proceed to **Installing the AMD RAIDXpert2 Management Suite for Linux** on page 42.

---

### Installing the AMD-RAID drivers during a Ubuntu 12.x Desktop Linux installation

**NOTE:** Prior to starting this procedure, obtain the AMD-RAID drivers from your system supplier or motherboard vendor. Copy the AMD-RAID drivers to the `/dd` directory on a USB flash drive, following the instructions in **Copying AMD-RAID drivers in a Linux environment** on page 35.

**NOTE:** The Ubuntu driver CD-ROM `.iso` image contains all Linux variations for a particular release.

**NOTE:** Some of the windows indicated in this procedure might not appear during the installation.

1. Power-on the system.
2. Insert the Ubuntu Desktop Linux operating system CD-ROM or DVD into the system's CD or DVD drive.
3. Create a bootable array by following the procedure in **Create Arrays** on page 28.
4. As soon as Ubuntu Desktop Linux kernel starts loading, press **F6** to go to **Advanced Options**.
5. Select the desired language and press **Enter**.
6. Press **F6** - Other Options
7. Press **ESC**
8. Press the **down arrow** to Install Ubuntu
9. At the end of the **Boot Options** string add `Type = break=mount` and press **Enter**.
10. When the BusyBox shell is displayed perform the following steps:
   a. Install the USB flash drive.
   b. Type: `mount -t vfat /dev/sd\x/x1 /tmp`, where \x is the drive letter of the flash drive.
   c. Type: `cp -ap /tmp/dd /`
   d. Type: `/dd/pre_install`
   e. Type: `umount /tmp`
   f. Type: `exit`

12. Select the desired Language and click **Continue**.
13. Accept the defaults and click **Continue**.
14. Select **Erase Disk and install Ubuntu**, and then click **Continue**.
15. From the **Select Drive** drop-down menu, select the AMD Array, and then click **Install Now**.
16. Select the desired **Time Zone** and click **Continue**.
17. Select the desired **Keyboard** layout and click **Continue**.
18. Enter valid entries for the following:
   a. Your name
   b. Computer name
   c. User name
   d. Password
   e. Confirm Password
19. Click **Continue**
20. When the Installation Complete window is displayed, perform the following steps:
   a. Press **CTRL + ALT + F1**
   b. Enter `sudo mount -t vfat /dev/sd\x/x1 /mnt`, where \x is the drive letter of the flash drive.
   c. Enter `sudo cp -ap /mnt/dd /`
   d. Enter `sudo /dd/post_install`
21. Wait for the Setup is Complete message and then press **CTRL + ALT + F7**
22. Click **Restart Now** to finish the installation.
23. When prompted to remove the installation media, remove the CD/DVD and USB flash drive from the system and press **Enter**.
24. Proceed to Installing the AMD RAIDXpert2 Management Suite for Linux on page 42.

### Installing the AMD RAIDXpert2 Management Suite for Microsoft Windows

Obtain the latest Catalyst executable file from your system supplier or motherboard vendor. Download the file to the system’s Desktop and execute it. Follow the on-screen prompts.

See **Browser setup** on page 45 for supported browsers and configurations.
Installing the AMD RAIDXpert2 Management Suite for Linux

Obtain the AMD RAIDXpert2 Management Suite executable file (`Setup.sh`) from your system supplier or motherboard vendor. Download the `Setup.sh` file to the system’s desktop.

Table 14  Linux procedure for installing the Management Suite

<table>
<thead>
<tr>
<th>Element</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ubuntu only</td>
<td>For Ubuntu 32-bit OS, enter the following commands before executing Setup.sh:</td>
</tr>
<tr>
<td></td>
<td>• sudo ln -s /lib/i386-linux-gnu/ libc.so.6</td>
</tr>
<tr>
<td></td>
<td>• /lib/libc.so.6</td>
</tr>
<tr>
<td></td>
<td>• sudo apt-get install libstdc++5</td>
</tr>
<tr>
<td></td>
<td>For Ubuntu 64-bit OS, enter the following commands before executing Setup.sh:</td>
</tr>
<tr>
<td></td>
<td>• sudo ln -s /lib/x86_64-linux-gnu/ libc.so.6</td>
</tr>
<tr>
<td></td>
<td>• /lib/libc.so.6</td>
</tr>
<tr>
<td></td>
<td>• sudo apt-get install ia32.libs</td>
</tr>
</tbody>
</table>

**NOTE:** If entering `sudo apt-get install` fails, enter `sudo apt-get update` first and ensure your SUT can access the Internet.

<table>
<thead>
<tr>
<th>Element</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup.sh</td>
<td>a. Verify that the Setup.sh file is executable by right-clicking on the Setup.sh file on the system’s desktop.</td>
</tr>
<tr>
<td></td>
<td>b. From the pop-up menu, select the Properties category.</td>
</tr>
<tr>
<td></td>
<td>c. Click the Permissions tab.</td>
</tr>
<tr>
<td>Permissions tab</td>
<td>a. Ensure that the Execute or Executable checkbox(es) is/are selected.</td>
</tr>
<tr>
<td></td>
<td>b. Click Close.</td>
</tr>
<tr>
<td>Setup.sh icon</td>
<td>a. Double-click the Setup.sh icon that is on the desktop.</td>
</tr>
<tr>
<td></td>
<td>b. At Do you want to run ‘Setup.sh’ or display its contents? click Run</td>
</tr>
<tr>
<td></td>
<td>c. Wait while Linux runs the Management Suite installer.</td>
</tr>
<tr>
<td>Introduction window</td>
<td>Click Next.</td>
</tr>
<tr>
<td>License Agreement window</td>
<td>a. Select I accept the terms of the License Agreement.</td>
</tr>
<tr>
<td></td>
<td>b. Click Next.</td>
</tr>
<tr>
<td>What would you like to install? window</td>
<td>Click Next.</td>
</tr>
<tr>
<td>Choose Install Folder window</td>
<td>a. Accept the default settings.</td>
</tr>
<tr>
<td></td>
<td>b. Click Next.</td>
</tr>
<tr>
<td>Choose Shortcuts window</td>
<td>Click Next.</td>
</tr>
<tr>
<td>Pre-Installation Summary window</td>
<td>a. Review the selections.</td>
</tr>
<tr>
<td></td>
<td>b. If they are okay, click Install.</td>
</tr>
</tbody>
</table>

**NOTE:** The Installing the AMD RAIDXpert2 Management Suite window appears, showing the progress of the installation.

<table>
<thead>
<tr>
<th>Element</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Complete window</td>
<td>Click Done.</td>
</tr>
</tbody>
</table>
Installing the AMD RAIDXpert2 Graphical User Interface (GUI)

This section provides instructions for installing the AMD RAIDXpert2 GUI for Linux. For information on using the GUI, see AMD RAIDXpert2 Graphical User Interface (GUI) on page 45.

SLED Linux

1. Copy xampp-linux-1.8.1.tar.gz to the desktop.
2. Open a console window.
4. Start Super User (su) mode and enter:
   
   ```
   tar xvfz xampp-linux-1.8.1.tar.gz -C /opt
   cd /opt/raidxpert2/htdocs
   cp -rv raidxpert2 /opt/lampp/htdocs
   ```
5. To start lamp, enter:
   
   ```
   /opt/lampp/lampp start
   ```
6. Restart Apache. Enter:
   
   ```
   ./usr/lampp/lampp startapache
   ```

**NOTE:** This must be done after each system reboot.

A RAIDXpert2 icon appears on the desktop.

Ubuntu Linux

1. Copy xampp-linux-1.8.1.tar.gz to the desktop.
2. Open a console window.
3. Navigate to /root/Desktop and enter:
   
   ```
   sudo tar xvfz xampp-linux-1.8.1.tar.gz -C /opt
   cd /opt/raidxpert2/htdocs
   sudo cp -rv raidxpert2 /opt/lampp/htdocs
   ```
4. To start lampp, enter:
   
   ```
   sudo /opt/lampp/lampp startapache
   ```
5. Restart Apache. Enter:
   
   ```
   runlevel
d /etc/rc2.d
   sudo ln -s /opt/lampp/lampp S99lampp
   sudo ln -s /opt/lampp/lampp K01lampp
   ```
   Where `runlevel` is the default runlevel for your system.

**NOTE:** This must be done after each system reboot.

A RAIDXpert2 icon appears on the desktop.
RAIDXpert2 Graphical User Interface (GUI)

Start RAIDXpert2

RAIDXpert2 can be accessed using a web browser or Windows shortcut.

Web-browser Access

Browser setup

- Use Chrome version 20, Firefox version 14, Internet Explorer 8, or Safari 6, or a greater version of each.
- To optimize the display, use a color monitor and set its color quality to the highest setting.
- To navigate beyond the Sign In page (with a valid user account):
  - Set the browser’s local-intranet security option to medium or medium-low. For Internet Explorer 8, adding the controller’s network IP address as a trusted site can avoid access issues.
  - Verify that the browser is set to allow cookies at least for the IP address of the controller.
- To see the help window in Microsoft Internet Explorer, you must enable pop-up windows.

Signing in using a web browser

1. In the web browser’s address field, type the IP address of a controller network port and press Enter. The AMD RAIDXpert2 Management Tool Login is displayed. If the Login page does not display, verify that you have entered the correct IP address.
2. On the Login page, enter the name and password of a configured user. The default user name and password are admin and admin.

**NOTE:** Both usernames and passwords are case-sensitive.

3. Select a language at the drop-down menu.
4. Click Submit. If the system is available, the RAIDXpert2 GUI page is displayed; otherwise, a message indicates that the system is unavailable.

Tips for signing in and signing out using a web browser

- Do not include a leading zero in an IP address. For example, enter 10.1.4.33 not 10.1.4.033.
- Multiple users can be signed in to each controller simultaneously.
- For each active RAIDXpert2 session an identifier is stored in the browser. Depending on how your browser treats this session identifier, you might be able to run multiple independent sessions simultaneously. Internet Explorer can run separate RAIDXpert2 sessions if you select File > New Session. If you do not select a new session, all instances of Internet Explorer share the same session.
- End a RAIDXpert2 session by selecting Options > Logout. Do not simply close the browser window.

Windows Shortcut Access

Signing in using a Windows shortcut

1. Launch the AMD RAIDXpert2 Management Tool using the Windows shortcut. The AMD RAIDXpert2 Management Tool Login is displayed. If the Login page does not display, verify that you have used the correct shortcut.
2. Select a language at the drop-down menu.
3. On the Login page, enter the name and password of a configured user. The default user name and password are `admin` and `admin`.

NOTE: Both usernames and passwords are case-sensitive.

4. Click Submit. If the system is available, the RAIDXpert2 GUI page is displayed; otherwise, a message indicates that the system is unavailable.

Password Protection

When the system displays a window that prompts you to choose a username and password, use the procedure below.

1. In the Username field, enter the new username.
2. In the Password field, enter the new password. Follow the guidelines in Things to Know About Passwords.
3. In the Confirm New Password field, re-enter the new password.

NOTE: Both usernames and passwords are case-sensitive.

4. Click Submit.

Things to Know About Passwords

- RAIDXpert2 cannot be opened without a password. Create a password that is easily remembered.
- The password must be 4 - 20 characters long.
- The password is case-sensitive.
- The application does not track previous passwords unless enabled through your web browser.
- To change an existing password, see Change a Password at the Options Menu on page 46.
- If a user forgets the username or password, delete `rc_login.txt` to restore the default user name and password (`admin` and `admin`).

Change a Password at the Options Menu

NOTE: Both usernames and passwords are case-sensitive.

1. At the Options menu, select Password.
   The Choose a new Username and Password window displays.
2. In the Old Password field, enter the default password you used to login.
3. In the New Password field, enter the new password. Follow the guidelines in Things to Know About Passwords.
4. In the New Password field, re-enter the new password.
5. Click Submit.

Help and About Windows

To view the software version and build number for the GUI, select About at the Help menu. The AMD RAIDXpert2 Driver Version and GUI Version displays.

For customer support, select Help > User Guide. A `pdf` version of this document will display. A `pdf` reader will be necessary to view it.

For further customer support, contact your system supplier or motherboard vendor.
Reviewing the RAIDXpert2 GUI

The Array View Section of the Array Status Window

Elements of the Array View Section

The Array View section presents a graphical view of array properties. Table 15 provides information about the elements of the Array View section.

Table 15  Elements of the Array View section, Array Status window

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controller Name</td>
<td>The RAIDXpert2 controller for the arrays displayed below it.</td>
</tr>
<tr>
<td>Array</td>
<td>The number assigned to an array.</td>
</tr>
<tr>
<td>Array name</td>
<td>The name assigned to an array.</td>
</tr>
<tr>
<td>RAID level</td>
<td>The RAID level of the array.</td>
</tr>
<tr>
<td>Disk Number</td>
<td>The number assigned to disks in an array.</td>
</tr>
<tr>
<td>Disk Manufacturer</td>
<td>The manufacturer of disks in an array.</td>
</tr>
<tr>
<td>Disk Model Number</td>
<td>The model number of the disks in an array.</td>
</tr>
</tbody>
</table>

The Disk List Section of the Array Status Window

Elements of the Disk List Section

The Disk List section provides information about all disks assigned or available to arrays. Table 16 provides information about the elements of the Disk List section.

Table 16  Elements of the Disk List section, Array Status window

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk</td>
<td>Disk number.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Disk capacity:</td>
</tr>
<tr>
<td></td>
<td>1 MB = 1,000,000 bytes</td>
</tr>
<tr>
<td></td>
<td>1 GB = 1,000,000,000 bytes</td>
</tr>
</tbody>
</table>

**NOTE:** Because the ATA storage industry has standardized the meanings of MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2 reports the same units.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Type</td>
<td>Type (SATA) and negotiated speed (not the speed of the port type).</td>
</tr>
<tr>
<td>GS</td>
<td>Indicates if the disk is assigned as a global spare.</td>
</tr>
<tr>
<td>State</td>
<td>State of the disk (Online, Offline, SMART Error).</td>
</tr>
<tr>
<td>Type</td>
<td>Disk type (Disk, Legacy, New).</td>
</tr>
<tr>
<td>Model</td>
<td>Disk manufacturer’s model number.</td>
</tr>
<tr>
<td>Serial No.</td>
<td>Disk manufacturer’s serial number.</td>
</tr>
<tr>
<td>Firmware</td>
<td>Disk manufacturer’s firmware version.</td>
</tr>
<tr>
<td>Space Available</td>
<td>Total amount of space unused on the disk.</td>
</tr>
</tbody>
</table>
Table 16  Elements of the Disk List section, Array Status window (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Largest Available</td>
<td>Largest contiguous unused space on the disk.</td>
</tr>
<tr>
<td>Features</td>
<td>Information about port communication and physical disk cache settings.</td>
</tr>
</tbody>
</table>

**NOTE:** If a disk is missing from the Disk List, the most likely cause is:
- A loose cable. Make sure that all disk cables are connected, then perform a rescan.
- A disk that is not fully seated in its bay or slot. Make sure that the disk is inserted completely in its bay or slot, then perform a rescan.

For more information, see Rescan Disks on page 51.

The Array List Section of the Array Status Window

Elements of the Array List Section

The Array List section provides information about the arrays. Table 17 provides information about the elements of the Array List section.

Table 17  Elements of the Array List section, Array Status window

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>The array number.</td>
</tr>
<tr>
<td>Partition</td>
<td>Drive letter that was assigned to this array during the partition process. (A blank space appears if the array has not been partitioned.)</td>
</tr>
</tbody>
</table>

**NOTE:** If a dynamic volume is created on an array, RAIDXpert2 cannot retrieve the volume’s drive letter.

<table>
<thead>
<tr>
<th>Array Name</th>
<th>User-created name for the array.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The RAID level (RAID type) or LEGACY.</td>
</tr>
</tbody>
</table>
| Total Capacity | Total capacity:  
1 MB = 1,000,000 bytes  
1 GB = 1,000,000,000 bytes |

**NOTE:** Because the ATA storage industry has standardized the meanings of MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2 reports the same units.

<table>
<thead>
<tr>
<th>State</th>
<th>State of the array (NORMAL, CRITICAL, OFFLINE).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
<td>Task type, if in progress (TRANSFORM, CHECK, CHECK_BITMAP, CREATE, RESTORE, ZERO, SECURE_ERASE).</td>
</tr>
<tr>
<td>Task State</td>
<td>The state of the task (STARTED, PAUSED, COMPLETED); the progress of the task is given in the Array View section.</td>
</tr>
<tr>
<td>Pri</td>
<td>Task priority if a task is in progress.</td>
</tr>
</tbody>
</table>
The Event View Section of the Array Status Window

Elements of the Event View Section

The Event View section is an optional-view section. It can be displayed or hidden by selecting View > Event View.

The information in the Event View is linked to the View Log. The View Log displays user-initiated tasks or actions, and system-generated notifications and events. The View Log can be accessed by selecting View > Log.

The Event View provides information about the events. Table 18 provides information about the elements of the Event View section.

Array and Disk Commands

The Array and Disk menus of the Array Status window contain lists of commands. The commands allow the system user to initiate or modify array- and disk-related tasks.

Not all commands are available for an array or for the system. Availability depends on:

- The tasks that can be performed with the system’s license level.
- The RAID level of an array. For example, a Consistency Check can be performed only on arrays at a redundant RAID level.
- The remaining capacity of the disk drives. For example, if a system has three disk drives and large arrays have used all of the capacity on two of the disks, only non-redundant Volume arrays can be created on the remaining disk. Certain commands are not available with a non-redundant array.

Table 19 provides page numbers for each command.
Working with Disks

Initialize Disks

When a disk is initialized, RAIDXpert2 configuration information (metadata) is written to the disks. If a disk is new and has not been used before, or if it is a legacy disk, it must be initialized before it can be used in a RAIDXpert2 array. After a disk is initialized, it appears as Disk in the Disk List.

△ CAUTION: Do not initialize a disk that is part of an array. Initializing a disk in a non-redundant array deletes the array and its data. The array no longer appears in Array View. This is especially true for a non-redundant bootable array. Initializing a disk in a non-redundant bootable array causes the array to Fail and deletes the operating system, RAIDXpert2 files, and device drivers.

Initializing a disk in a redundant array causes the array to become Critical. Initializing two or more disks in a redundant array deletes the array and its data. The array no longer appears in Array View.

△ CAUTION: All new disks and legacy disks appear as legacy arrays in the Array View and Array List until they are initialized.

△ CAUTION: A legacy disk can contain valid data. When a legacy disk is initialized, all data on the disk is lost.
To initialize disks

1. At the Disk menu, select Initialize. The Initialize Disk window displays.
2. Select the disk(s) to be initialized, by selecting the box next to the disk(s).
3. Click Initialize Selected.

Rescan Disks

The Rescan command:
• Rescans the SATA channels that search for new, legacy, or removed disks.
• Rereads the configuration information from each disk.

When a disk is offline, it might be brought online by using a rescan. A rescan also stops and then automatically resumes all tasks.

To rescan disks, select Rescan at the Disk menu.

Change Cache Properties for Disks

The Read Ahead and Write Back Cache properties can be changed if the disks support this option. The default settings are:
• Read Ahead: enabled.
• Write Back Cache: enabled.

⚠️ CAUTION: Leaving Write Back Cache enabled can increase the likelihood of data being corrupted if the system experiences a power interruption or unexpected shutdown.

NOTE: A disk’s cache setting cannot be changed if a task is active for the array. The cache settings are enabled when the task is finished.

Change disk caching properties

1. At the Disk menu, select Properties. The Properties window displays.
2. Select the disks.
3. Click Enable or Disable for the desired settings.

NOTE: Each time Enable or Disable is clicked, the disk selection clears. To change multiple settings on one disk, select the disk before clicking each setting.

Assign Spares

Spare disks allow an array to be rebuilt when a disk fails. Global spares can be used in any array, while dedicated spares are assigned to a specific array.

Assign a disk as a dedicated or global spare

1. In the Disk List section, select a disk.
2. At the Disk menu, select Spare/Identify.
   Options for Disk Device displays in the Disk List panel.
3. Perform one of the following actions:
   • To use the disk as a dedicated spare, select **Assign as Dedicated Spare**.

   **NOTE:** The capacity of a dedicated spare must be equal to or larger than the capacity of the smallest disk in the array.

   • To use the disk as a global spare, select **Assign as Global Spare**.

4. Click **Confirm**.

## Legacy Disks

A legacy disk is a disk that contains valid data from a non-RAID controller.

A legacy disk appears in RAIDXpert2 (and in the BIOS Configuration Utility) with a corresponding legacy array. When the legacy disk is initialized in RAIDXpert2 (or in the BIOS Configuration Utility), the legacy array disappears.

**CAUTION:** A legacy disk can contain valid data. When a legacy array is deleted, or when its corresponding legacy disk is initialized, the data is lost.

### Legacy disks and New disks

Table 20 provides information on how disks appear in RAIDXpert2 and in the BIOS Configuration Utility.

**Table 20** New and legacy disks, as they appear in the BIOS Configuration Utility and RAIDXpert2

<table>
<thead>
<tr>
<th>Status of the Disk</th>
<th>In RAIDXpert2</th>
<th>In the BIOS Configuration Utility</th>
</tr>
</thead>
<tbody>
<tr>
<td>New, un-initialized disk.</td>
<td>The disk appears as a new disk with a legacy array.</td>
<td>The disk appears as a new disk (the disk can appear with a legacy array). When the new disk is initialized, RAIDXpert2 configuration data is written to the disk. The disk state changes to Empty.</td>
</tr>
<tr>
<td></td>
<td>When the new disk is initialized, its state changes to Online (or similar).</td>
<td>When the new disk is initialized, RAIDXpert2 configuration data is written to the disk. The disk state changes to Empty.</td>
</tr>
</tbody>
</table>

| A disk containing non-RAIDXpert2 configuration data.    | The disk appears as a legacy disk with a legacy array.  | The disk appears as a legacy disk with a legacy array. |
|                                                        | When the legacy disk is initialized (or the legacy array is deleted), the legacy array disappears and the legacy disk type changes to Disk. The disk can now be used in RAIDXpert2 arrays. | When the legacy array is deleted the state of the legacy disk changes to Empty. The disk can now be used in RAIDXpert2 arrays. |

**CAUTION:** A legacy disk can contain valid data. When a legacy array is deleted, or when its corresponding legacy disk is initialized, the data is lost.

See BIOS Configuration Utility for the disk initialization procedure and the appearance of legacy disks in the BIOS Configuration Utility.

## Working with Arrays

### Create and Format Arrays

RAIDXpert2 allows the partitioning and creation of as many as eight arrays across the system’s disks. Portions of disks can be used to create arrays, at the same time that other arrays use different portions of the same disks.
Before you begin...

Review the issues and recommendations indicated in Table 21.

Table 21  Creating arrays: Issues and recommendations

<table>
<thead>
<tr>
<th>Issues</th>
<th>Recommendations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access to arrays</td>
<td>The creation of arrays, even redundant arrays, allows users immediate access to the arrays (unless the Zero Create option is used during the Create process).</td>
</tr>
<tr>
<td>Array numbers</td>
<td>Array numbers are valid only for a given boot, and can be different in the BIOS Configuration Utility and RAIDXpert2. If a permanent label is required, use the Array Naming feature described in Name Arrays on page 54.</td>
</tr>
<tr>
<td>Array size</td>
<td>The array size of the new array is limited to 2.199 TB on some versions of Windows and Linux. Refer to the operating system documentation for details on maximum array sizes.</td>
</tr>
<tr>
<td>Number of arrays</td>
<td>In some circumstances, more than eight arrays are possible. They might appear to function properly, but are not supported by AMD-RAID.</td>
</tr>
<tr>
<td>System reboot</td>
<td>When the system reboots, the creation process continues where it left off.</td>
</tr>
</tbody>
</table>

Create an array

Select an array and cache

1. At the Array menu, select Create.
2. Select the disk(s) to include in the array by checking the box next to the desired disk(s) in the Select Active Disks: field.

NOTE: Click All to select all disks, or click Unused to select disks that are not currently used in an array.

3. Enter a name for the array in the Array Name: field.

NOTE: The following characters are not allowed in an array name:

( ) ^ , | = “ ” .

4. Select an array type at the Array Type: drop-down menu.
5. At the Organized As: drop-down menu select an option.

NOTE: The Organized As: drop-down menu only displays options for advanced management of RAID10 and RAID50 configurations if you selected a RAID10 or RAID50.

6. Enter the capacity in the Capacity: field.

NOTE: The maximum available capacity changes with:
• The disks that are selected.
• The RAID level of the array.

TIP: For creating volumes larger than 2 TB, see Table 36 on page 71.

7. Select a cache option at the Cache Options: drop-down menu. (The default is Read and Write Back Cache.)
8. Check **Background Array Scan** to enable background array scanning. (A background array scan checks the sectors of the disks in an array for potential problems. A background array scan runs continuously, until the user stops it by accessing **Array > Background Array Scan > Stop**.

**NOTE:** See **Scan an Array in the Background** on page 61 for details.

9. Check **Skip Initialization** to skip initialization.

**CAUTION:** Creating a redundant array with **Skip Initialization** selected can result in data corruption.

10. Check **Leave Existing Data Intact** if an array is lost or deleted, and the user immediately creates a replacement array of the same characteristics. This leaves the data on the disks of the lost or deleted array untouched when the replacement array is created. See **Table 37** on page 72 for additional information.

11. Check **Zero Create** to write zeros on the created array. If **Zero Create** is used, the array is not immediately available (the array is hidden from the operating system during the Create process).

12. Click **Create** to create the array.

**Partition and format an array**

Each operating system has different names and paths for partitioning and formatting arrays and as such are outside the scope of this document. For more information, see your operating system’s user documentation.

**Name Arrays**

Naming an array can be useful when creating backups. It makes an array easy to identify in a list of arrays.

1. In the Array View section, select the array to name.

2. At the **Array** menu, select **Name**.

   The Array Name window displays.

3. Type the desired name in the blank field.

**NOTE:** The following characters are not allowed in an array name:

```
( ) ^ , | = “ ”
```

4. Click **OK**.

**NOTE:** The array name appears in the Array List and in the BIOS Configuration Utility (only 17 characters of the name are displayed in the BIOS Configuration Utility).

**Transform Arrays (supported by RAIDXpert2 Plus)**

With the Transform task, an array can be:

- Transformed from one RAID level to almost any other RAID level. This function is also referred to as **Online RAID Level Migration (ORLM)**.
- Expanded dynamically, even under I/O load, by adding disks to the array to increase the capacity of the array. This function is also referred to as **Online Capacity Expansion (OCE)**.
Before you begin...

Review the issues and recommendations indicated in Table 22.

Table 22  Transforming arrays: Issues and recommendations

<table>
<thead>
<tr>
<th>Issues</th>
<th>Recommendations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array size</td>
<td>An array cannot be transformed to a smaller-sized array. The transformed array must be the same size as or larger than the original array.</td>
</tr>
<tr>
<td>Array size limits</td>
<td>The array size of the transformed array is limited to 2.199 TB on some versions of the Windows and Linux operating systems. Refer to the operating system documentation for details on maximum array sizes.</td>
</tr>
<tr>
<td>Disk failure during a Transform</td>
<td>If a disk fails while the Transform task is in progress, no data is lost as long as the source and destination RAID levels are redundant. If a spare has been assigned to the destination array, a fail-over task starts as soon as the Transform completes (if the spare is available after the Transform).</td>
</tr>
<tr>
<td>Multiple arrays</td>
<td>If there are multiple arrays, it might not be possible to transform some of the arrays to a larger size. If, in the future, an array needs to be expanded in size, it is best to configure the available space as a single array.</td>
</tr>
<tr>
<td>Task control commands</td>
<td>When using task control commands, a Transform task can only be paused or resumed but not removed. To end a Transform task, pause and delete it.</td>
</tr>
<tr>
<td>System reboot during a Transform</td>
<td>If the system reboots during a Transform, the Transform continues where it left off.</td>
</tr>
</tbody>
</table>

Transform an array

1. In the Array View section, select the array to transform.
2. At the Array menu, select Transform.

❗️ NOTE: If the system window is not wide enough, only the Destination View is displayed.

3. Select all the desired disks for the array (including disks that might be already in the array) by selecting the box next to the drive in the Disk List section.

❗️ NOTE: Click Same to select all disks currently used in the array, All to select all disks, or Unused to select disks that are not currently used in an array.

4. Select the RAID level to be transformed at the Array Type: drop-down menu.
5. At the Organized As: drop-down menu select an option.

❗️ NOTE: The Organized As: drop-down menu only displays options for advanced management of RAID10 and RAID50 configurations if you selected a RAID10 or RAID50.

6. Expand the array by entering the size of the new array in the Capacity: field.
NOTE: The maximum available capacity changes with:
- The disks that are selected.
- The RAID level of the array.

TIP: For creating volumes larger than 2 TB, see Table 31 on page 69.

NOTE: If a Transform is not possible, the Commit option is not enabled. A typical reason preventing a Transform is insufficient available space on the disks.

7. Click Commit.

NOTE: If the system is not licensed for RAIDXpert2 Plus, a License Issue message displays when the user clicks Commit.

NOTE: Unless the transformation is instantaneous, the Array Status window updates to show the source and destination arrays, along with the progress of the transformation.

Access Additional Space
After an array has been transformed to a larger size, use the operating system tools to access the additional space. There are several possible methods for expanding the existing file system on an array that has been transformed to a larger size:
- Microsoft provides a command prompt utility called Diskpart.exe that can expand any NTFS file system without requiring a reboot. The Diskpart.exe utility version to use depends on the version of Windows being run. The Diskpart.exe utility can be found on the CD that comes with some versions of Windows, or at the Microsoft website (http://www.microsoft.com) for others. Use the correct version for the operating system.
- For arrays formatted with FAT32, use a third-party application, such as PartitionMagic® from PowerQuest Corporation.

Restore (Rebuild) Arrays
With the Restore task, a redundant-type array whose state has changed to Critical can be restored (rebuilt) in one of two ways:
- By assigning a dedicated spare to the array.
- By creating a global spare or by using an existing global spare. (An existing global spare automatically starts restoring a redundant-type array after the array’s state changes to Critical.)

An array in an Offline state cannot be restored. This means that non-redundant arrays (Volume, RAID0) cannot be restored: when a single disk in a non-redundant array fails, the array state changes to Offline.

NOTE: If a Critical redundant array that is being restored loses a second disk (RAID1 or RAID5), or loses a second disk in the same mirror set (RAID10), or the third disk of a RAID6 array, the Restore task fails. The array must be re-created from backup storage data.
Before you begin...

- Make sure that the disk chosen as the dedicated spare or global spare has sufficient available capacity to restore the array. The capacity of the spare disk must be equal to or larger than the capacity of the smallest disk in the critical array.

- Know how to create a global or dedicated spare. See Add or Remove Dedicated Spares on page 61 or Add or Remove Global Spares on page 61.

**Restore a Critical array**

1. In the Array View section, select the critical array.
2. At the Disk List section, select a disk.
3. At the Disk menu, select **Spare/Identify**.
   - Options for Disk Device displays in the Disk List panel.
4. Perform one of the following actions:
   - To use the disk as a dedicated spare, select **Assign as Dedicated Spare**.
   - To use the disk as a global spare, select **Assign as Global Spare**.
5. Click **Confirm**.

**Prepare to Physically Remove an Array**

**Physically remove an array**

⚠️ **CAUTION:** Prior to removing an array, remove its drive letter (Windows) or unmount the array (Linux).

1. In the Array View section, select the array to remove.
2. At the Array menu, select **Prepare to Remove**.
3. At the Prepare to Remove window, click **Yes**. The array and all associated disks disappear from the Array Status window.
4. Remove the first disk from the system.
5. When the Drive Removed window displays, click **Cancel**.
6. Remove the remaining disks in the array.
7. When all disks in the array have been removed from the system, select **Rescan** at the Disk menu.

**Array migration**

The disks in an array, after being removed from one system with a RAIDXpert2 controller, can be migrated to another system with a RAIDXpert2 controller. The disks and array(s) appear in the second system, in Disk Management, the BIOS Configuration Utility, and RAIDXpert2, as normal RAIDXpert2 disks and array(s).

If the disks from a RAIDXpert2 system are migrated to a non-RAIDXpert2 Windows-based system, the disks appear in Disk Management of the second system as healthy, unknown partitions. To use the disks, use Disk Management to delete the RAIDXpert2-created partitions and to create Windows partitions on the disks.

⚠️ **CAUTION:** All data contained in a RAIDXpert2 array are lost if the RAIDXpert2 disks of the array are migrated to a non-RAIDXpert2 system.

**Delete Arrays**

⚠️ **CAUTION:** Deleting an array permanently destroys all data that is on the array. This action cannot be undone and it is very unlikely the data can be recovered.
Before you begin...

Review the issues and recommendations indicated in Table 23.

### Table 23  Deleting arrays: Issues and recommendations

<table>
<thead>
<tr>
<th>Issue</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive letters or partitions</td>
<td>Remove drive letters or partitions from the array using procedures in your operating system. Each operating system has different names and paths for removing drive letters or partitions and as such are outside the scope of this document. For more information, see your operating system’s user documentation.</td>
</tr>
<tr>
<td>Operating system impact on arrays</td>
<td>If the array is not being used by the operating system, the array can be deleted at any time, even while tasks are running on the array. If the array is being used by the operating system, the array cannot be deleted. Therefore, a RAIDXpert2 bootable array cannot be deleted in RAIDXpert2. A RAIDXpert2 bootable array can only be deleted in the BIOS Configuration Utility.</td>
</tr>
</tbody>
</table>

#### Delete an array

1. In the Array Status window, select the array to deleted.
2. At the **Array** menu, select **Delete**.
   - A Delete window displays, with a warning about deleting the array.
3. Click **OK**.
4. The array disappears from the Array View section.

〈 TIP:  Also see Delete Arrays on page 30. 〉

#### Recreate a deleted array

If an array is deleted, it might be possible to recreate the array. See Table 37 on page 72.

#### Change Cache Settings for Arrays

*Table 24* provides information about the four array-caching options available.

### Table 24  Cache array options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Cache</td>
<td>I/O requests are translated and passed to the disks without keeping a cached copy of the data available for future requests.</td>
</tr>
<tr>
<td>Read Cache</td>
<td>Data reads are cached, if appropriate. This option performs sequential Read Ahead, when necessary.</td>
</tr>
<tr>
<td>Write Back Cache</td>
<td>Data writes are cached. This setting is intended for advanced users who understand the implications of Write Back caching.</td>
</tr>
<tr>
<td>Read + Write Back Cache (default setting)</td>
<td>Both Read and Write Back Cache options can be selected.</td>
</tr>
</tbody>
</table>

〈 NOTE:  Cache options cannot be changed while a task is active on the array. They can be changed at any other time, including while I/O is running. 〉
Change cache settings

1. In the Array View section, select the array on which to change caching options.
2. At the Array menu, select Modify Cache Settings.
3. Choose No Cache, Read Cache, Write Back Cache, or Read + Write Back Cache.

The new cache setting displays in the Array List Cache information.

Change the Priority Level of a Task

The task priority command allows the user to speed up or slow down tasks being performed on arrays. To decrease the amount of time it takes for a task to complete, set the task priority higher (10 is the highest).

NOTE: A task priority can only be changed after a task is running on the array.

To change a task priority

1. In the Array View section, select the array on which tasks are being performed.
2. At the Array menu, select Task and select Priority.
3. At the Task Priority window, change the task priority by moving the slide one way or the other.
4. Click OK.

Interrupt, Cancel, or Resume a Task

The task control commands allow the user to pause, resume, or cancel (remove) tasks being performed on arrays. Full task control can be used on Create, Consistency Check, and Check Bitmap tasks. On Restores with dedicated or global spares the task can be removed, but the array returns to the Critical state.

NOTE: Task control can be used only when a task is running on an array.

Interrupt, cancel, or resume a task

1. In the Array View section, select the array on which a task is being performed.
2. At the Array menu, select Task and click:
   • Pause to interrupt the task.
   • Remove to cancel the task.
   • Resume to interrupt the task.

Check for Consistency

For redundant-type arrays only, the Consistency Check task is available at the Array menu. When this task is selected it starts the process of verifying that the parity (RAID5 or RAID6) or mirror drive consistency for fault-tolerant disks is correct. If inconsistent areas are found, they are corrected during this process.

Having consistent arrays is very important. If an array is inconsistent and a drive fails, data is lost. RAIDXpert2 is designed to maintain consistent arrays, but it is good practice to run frequent consistency checks. See Schedule a Consistency Check on page 60.

When a redundant array is created using the Create command, and the Skip Initialize option is not checked (the default setting), a Consistency Check is performed automatically. Although a Consistency Check that runs during a Create task can be removed (by highlighting the array and selecting Task > Remove), the array that is created is not redundant. Unless a Consistency Check runs from end-to-end, an array is not protected.

After a Consistency Check has been started, adjust the priority of the Consistency Check task relative to user I/O activity. Use the Task Priority option (see Change the Priority Level of a Task on page 59).

A Consistency Check task can be scheduled with the Schedule Consistency Check task (see Schedule a Consistency Check on page 60).
Before you begin...

- The Consistency Check command can be started at any time on a redundant-type array, as long as another task is not running on the array.
- The Consistency Check command can be started while under I/O load.
- If the array state is Critical, the Consistency Check fails.
- To estimate the remaining time for a Consistency Check, look at the percentage of the task that is completed (in hours: minutes: seconds). These details are displayed next to the array in the Array View section of the Array Status window.

Manually start a Consistency Check

1. In the Array View section, select the array on which to run the Consistency Check.
2. At the Array menu, select Check Consistency.
3. Click Start.

Manually stop a Consistency Check

1. In the Array View section, select the array on which to stop the Consistency Check.
2. At the Array menu, select Check Consistency.
3. Click Stop.

Schedule a Consistency Check

A Consistency Check task can be scheduled for later in the day or week. A Consistency Check task can be scheduled to run each week or each month.

**NOTE:** Schedule only one Consistency Check event on an array. This means that if a monthly check has been scheduled and a weekly check is desired, delete the monthly event and schedule the new event.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>One Time Only</td>
<td>Schedule the Consistency Check for the current day (“Today”) or up to seven days in the future.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Events can be scheduled weekly. After it is selected, a Consistency Check runs on the specified array at the same time each week.</td>
</tr>
<tr>
<td>Monthly</td>
<td>Events can be scheduled to run once per month to run on the specified array at a specified time.</td>
</tr>
</tbody>
</table>

Table 25 provides information on the available scheduling options for a Consistency Check.

**Table 25** Consistency Check options

Schedule a Consistency Check for later

1. In the Array View section, select the array on which to run the Consistency Check.
2. At the Array menu, select Check Consistency.
3. Select Schedule.
4. At the Check Consistency window, select the Frequency, Day, and Time.
5. Click Confirm.

Delete a scheduled Consistency Check

1. In the Array View section, select the array to on which to delete the Consistency Check.
2. At the Array menu, select Check Consistency.
3. Select Schedule.
4. At the Consistency Check window, click Remove.
Scan an Array in the Background

A Background Array Scan task performs a continuous background read operation of an array, accessing at least one copy of every block of the array from beginning to end.

A Background Array Scan is manually started by the user and runs continuously until the user stops it.

Although a Background Array Scan can run while an array is engaged in other tasks, it is recommended that the Background Array Scan run while the array is idle (that is, when there is no I/O to or from the array).

Enable or disable a Background Array Scan

1. In the Array View section, select the array to on which to run the Background Array Scan.
2. At the Array menu, select Background Array Scan.
3. Enabled or disable the Background Array Scan.
   - To enable a Background Array Scan, select Start.
   - To disable a Background Array Scan, select Stop.

**NOTE:** A Background Array Scan can also be enabled for an array when it is created or copied.

Add or Remove Dedicated Spares

If a dedicated spare is added, make sure there is adequate space on the dedicated spare.

Add a dedicated spare

1. In the Array View section, select the array on which to assign a dedicated spare.
2. In the Disk List section, select the disk chosen as the dedicated spare.
3. At the Disk menu, select Spare/Identify.
4. Select Assign as Dedicated Spare.
5. Click Confirm.

Remove a dedicated spare assignment

1. In the Array View section, select the array from which to remove a dedicated spare.
2. At the Disk menu, select Spare/Identify.
3. Select Remove as Dedicated Spare.
4. Click Confirm.

**TIP:** For additional information see Sparing Options: Disks and Arrays on page 24.

Add or Remove Global Spares

If a global spare is being added, make sure there is adequate space on the global spare.

Add a global spare

1. In the Disk List section, select the disk chosen as the global spare.
2. At the Disk menu, select Spare/Identify.
3. Select Assign as Global Spare.
4. Click Confirm.

Remove a global spare

1. In the Disk List section, select the disk to be removed as the global spare.
2. At the Disk menu, select Spare/Identify.
3. Select Remove as Global Spare.
4. Click Confirm.
Use Mirror to Split an Array

Mirror split allows a RAID1 configuration to be split into two volumes.

NOTE: One of the resulting volumes will be hidden by default.

Split an array

1. In the Array View section, select the RAID1 array to split.
2. At the Array menu, select Mirror > Split.
3. Select either Default or Advanced.
   - If Default is selected, the second volume will be hidden.
   - If Advanced is selected, the user can select disks from the mirror to be included in the primary array. If enough healthy members remain, the disks not selected will be split into a secondary array.
4. Click Confirm.

Hide an Array

Hide allows the user to hide the array from the operating system.

Hide an Array

1. In the Array View section, select the array to hide.
2. At the Array menu, select Hide. The array will disappear from the Array View.

NOTE: If the array is currently hidden, select Array > Un-hide to display it.

Copy an Array

Copy allows users to make copies of an existing (source) array data to a new (destination) array.

Copy an array

1. In the Array View section, select the array to copy.
2. Follow steps 1 through 7 in Create an array.
3. Click Commit to start the Copy task.

NOTE: The capacity of the created array must be equal to or larger than the capacity of the array being copied.

NOTE: The array will be hidden.

Unlink Arrays

Unlink is only used after a Copy is complete. Prior to unlinking, the source array and the destination array will both contain any data written to the source array. After unlink is performed no data will be written to the destination (copied) array.

Unlink copied arrays

1. In the Array View section, select the copy array to unlink.
2. At the Array menu, select Unlink.
Secure Erase

Secure Erase is used for erasing all data on an array and ensuring that it will be unrecoverable, even with advanced data recovery techniques.

Data is securely erased by:

- Hiding the array from the OS
- Writing over each region of the disk with 3 patterns (0xAA, 0x55, and random)
- Using a 4 pass with all zeros to ensure that a RAID1, 5, 6, or 10 will be consistent

After the secure erase is complete, a user can choose to manually delete the array or reuse it. If the user chooses to reuse it, it must be unhidden using the procedure in Hide an Array on page 62.

△ CAUTION: When an array is securely erased, the data on the array is lost.

Securely erasing an array

1. In the Array View section, select the array to erase.
2. At the Array menu, select Secure Erase.

Working with Views

The View menu allows the user to:

- Display the event view.
- Display the event log.
- Refresh the display.

Display or hide Controller Event Log panel

To display or hide the Controller Event Log, select Event View at the View menu. When the Controller Event Log panel displays, a checkmark appears next to the Event View option at the View menu.

Log Window

The [system name]: View Log window displays all of the messages generated by RAIDXpert2. All messages are logged, not just the ones enabled at Options > Notification.

All messages received from the RAIDXpert2 driver are sent to a message log file. If desired, change the name of this file in the Notification window.

By default, notification events in Windows-based systems are saved to %Program Files%\RAIDXpert2\rc_service.log.

Notification events in Linux-based systems are saved to /var/log/rc_service.log.

At the View menu, select Log to view the RAIDXpert2 messages.

Refresh the Display

To refresh the display, select Refresh at the View menu.

Working with Options

Change Password Settings

A password can be changed at the Options menu. See Change a Password at the Options Menu on page 46.
Set Event Notifications

With the Notification option, the user can manage event log and email notifications of events.

The Event View section of the Array Status window displays the priority listing. The event log priority levels, in ascending order, are indicated in Table 26.

Table 26  Event Log priority levels

<table>
<thead>
<tr>
<th>Event Priority</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>Displays messages for normal system operations. (This event is not displayed unless requested by the user.)</td>
</tr>
<tr>
<td>Informational</td>
<td>Displays information that might be useful to know.</td>
</tr>
<tr>
<td>Warning</td>
<td>The system user should be informed about this event, but probably does not need to take action.</td>
</tr>
<tr>
<td>Critical</td>
<td>The system user must be informed about this event and should take action.</td>
</tr>
<tr>
<td>Fatal</td>
<td>The RAIDXpert2 driver is fatally damaged and the RAID subsystem has shut down.</td>
</tr>
</tbody>
</table>

Set or change event notifications

1. At the Options menu, select Notification. The Notification Setup window displays.
2. Specify the Outgoing Mail Server (SMTP) and To Email Address, to which e-mail messages are sent when an event occurs.
3. If the SMTP server requires a login, check the Server Required Login box and enter a valid Username and Password for the server.
4. Specify a user address as the sender of the e-mail notifications in From Email Address. (By default, the system on which RAIDXpert2 is installed is used.)
5. Click Send Test Message to verify that the e-mail notification works.
6. To disable messaging, uncheck the Enable Messaging check box in the Notification Events section.
7. Choose the types of notification events to use (Email or Event Log) for each event priority (Low, Informational, Warning, Critical, Fatal) by selecting the appropriate options.

NOTE: Warning, Critical, and Fatal events will always display in the Event Log.

Licensing

To display Licensing information, including available licensing levels, select License at the Options menu.

Add space using a RAIDABLE Array

1. Install a new disk. After a rescan, a pop-up window displays.

NOTE: To create a redundant RAID1 array, the new disk must be the same size or greater than the RAIDABLE disk.

2. In the Select a Disk section, select the new disk.
3. In the Choose a Task section, select the desired option.

**NOTE:** Selecting any option first initializes the disk before the selected task is started.

- **Backup Array.** This option creates a backup of the RAIDABLE array on the new disk.
- **Transform Array.** This option allows the user to either add space to the RAIDABLE array or create a redundant array.
- **Initialize Disk for AMD-RAID.** This option allows the disk to be used when creating arrays.
- **Make disk a Global Spare.** This option assigns the new disk as a global spare.

4. In the Select a Source/Destination section:
   - Select the **Source RAIDABLE Array** from the drop-down menu.
   - Select the **Destination Array Type** from the drop-down menu.

**NOTE:** The **Destination Array Type** option is only available when either the **Backup Array** task or **Transform Array** task is selected. Only valid array types for the number of disks inserted will be displayed. For example, if one new disk is inserted, only RAID0 or RAID1 will display in the drop-down menu.

5. Click **Confirm**.

If either the **Backup Array** task or **Transform Array** task is selected, a **Task Progress** dialog box displays. To hide the dialog box while the task is executing, click **Close**.
Troubleshooting

The chapter discusses four major categories of troubleshooting:

- Problems with system startup.
- Warning messages that might appear at the Power-On Self-Test (POST) screen.
- Problems with arrays.
- Problems with disks.

System Startup Problems

- The system does not boot on page 67
- The BIOS Configuration Utility does not display on page 67

Table 27  The system does not boot

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controller mode is set incorrectly during system startup</td>
<td>In the system’s BIOS screen, ensure SATA settings are in RAID mode.</td>
</tr>
</tbody>
</table>
| The system’s boot mode or boot sequence retry mode is set incorrectly | In the system’s BIOS screen, ensure that the bootable array is the first array listed.  
If not, use the Swap Two Arrays option to reposition the arrays. |
| A bootable array is in an Offline state             | 1. Restart the system.  
2. Enter the system’s BIOS screen.  
3. Check the state of the bootable array.  
4. Check for missing or offline disks.           |

Table 28  The BIOS Configuration Utility does not display

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The controller mode is set incorrectly in the system BIOS</td>
<td>In the system’s BIOS screen, ensure the SATA settings are correct.</td>
</tr>
</tbody>
</table>

Table 29  Username and password

<table>
<thead>
<tr>
<th>Problem</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>A user forgets the username or password.</td>
<td>Reset the username and password by deleting rc_login.txt. This restores the default user name and password (admin and admin).</td>
</tr>
</tbody>
</table>
Warning Messages: POST Screen

The POST screen is one of the first screens to appear during the system’s boot sequence. If the system’s arrays were in Normal or Ready state prior to a system boot, the boot sequence continues normally to the operating system.

But, if an array is in Critical or Offline state, or if specific options at Controller Options were changed previously at the BIOS Configuration Utility, the warning messages described in Table 30 appear during the boot sequence.

Table 30 POST screen warning messages

<table>
<thead>
<tr>
<th>Warning Message</th>
<th>Additional Information</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>WARNING: Found arrays that are Critical [or equivalent]</td>
<td>This warning message appears when at least one array is in a Critical state and <strong>Toggle Pause if Critical</strong> is set to <strong>ON</strong> at the BIOS Configuration Utility. The Critical state of an array depends on the RAID level of the array and the number of disks that have failed. See Array States on page 20 for information on criticality. If an array is Critical (even a bootable array), the system can continue through the boot process to the operating system.</td>
<td>See Troubleshooting Disks on page 73</td>
</tr>
<tr>
<td>WARNING: Found arrays that are Offline [or equivalent]</td>
<td>This warning message appears when at least one array is in an Offline state and <strong>Toggle Pause if Offline</strong> is set to <strong>ON</strong> at the BIOS Configuration Utility. If two or more disks in a redundant array have failed, or if a single or multiple disks in a non-redundant array have failed, data has been lost. In RAID10 array, if a single disk fails in each mirrored set, the redundant array goes to a Critical state but data is not lost. If two disks fail in one of the mirrored sets, the redundant array goes to an Offline state and data is lost. A bootable array that is in an Offline state prevents the operating system from booting.</td>
<td></td>
</tr>
<tr>
<td>WARNING: Found arrays that are Critical and Offline [or equivalent]</td>
<td>This warning message appears when at least one array is in a Critical state and <strong>Toggle Pause if Critical</strong> is set to <strong>ON</strong> at the BIOS Configuration Utility. The Critical state of an array depends on the RAID level of the array and the number of disks that have failed. See Array States on page 20 for information on criticality. If an array is Critical (even a bootable array), the system can continue through the boot process to the operating system. A bootable array that is in an Offline state prevents the operating system from booting.</td>
<td></td>
</tr>
<tr>
<td>BIOS NOT INSTALLED - User Disabled INT13 BIOS Load [or equivalent]</td>
<td>This warning message appears when <strong>Toggle INT13 Boot Support</strong> option has been set to <strong>OFF</strong> at the BIOS Configuration Utility and another boot device is not selected. Bootable devices do not function with the controller when <strong>Toggle INT13 Boot Support</strong> is set to <strong>OFF</strong>. The default setting is <strong>ON</strong>, which allows bootable devices to function with the controller.</td>
<td>1. Restart the system. 2. Enter the system’s BIOS screen. 3. Select <strong>Main Menu &gt; Controller Options &gt; Toggle INT13 Boot Support</strong>. 4. Change <strong>Toggle INT13 Boot Support</strong> from <strong>OFF</strong> to <strong>ON</strong>. 5. Navigate to <strong>Main Menu</strong>. 6. Select <strong>Continue to Boot</strong>. The system boot process continues to the operating system.</td>
</tr>
</tbody>
</table>
Array-Related Errors

- **Cannot create an array** on page 69
- **An array is in an Offline state** on page 70
- **An array is in a Critical state** on page 69
- **Cannot assign a dedicated spare to an array** on page 70
- **Cannot create a global spare** on page 70
- **Cannot create an array larger than 2.199 TB** on page 71
- **Recreate a deleted array** on page 72

### Table 31  Cannot create an array

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Additional Information</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The disk is not displayed.</td>
<td>The controller cannot communicate with the disks.</td>
<td>See Troubleshooting Disks on page 73.</td>
</tr>
<tr>
<td>Insufficient free space available on the selected disks</td>
<td></td>
<td>Select a different combination of disks.</td>
</tr>
<tr>
<td>Incorrect number of disks selected for the desired RAID level</td>
<td>See RAID Levels on page 19 for a description of RAID levels and the allowable number of disks used with each RAID level.</td>
<td>Select the correct number of disks.</td>
</tr>
<tr>
<td>The desired disk is unavailable.</td>
<td>• The disk is a dedicated spare for a different array.</td>
<td>Select a different disk.</td>
</tr>
<tr>
<td></td>
<td>• The disk is full.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The disk’s available capacity is insufficient.</td>
<td></td>
</tr>
<tr>
<td>The disk has SMART errors.</td>
<td>An array can be created with a disk that has SMART errors, but only if the array is created in the BIOS Configuration Utility. RAIDXpert2 cannot be used to create an array with a disk that has SMART errors.</td>
<td>Use the BIOS Configuration Utility to create the array.</td>
</tr>
<tr>
<td>The system already has a maximum of eight arrays</td>
<td>Delete unused arrays.</td>
<td></td>
</tr>
</tbody>
</table>

⚠️ **CAUTION:** Deleting an array permanently destroys all data that is on the array. This action cannot be undone and it is very unlikely the data can be recovered.

### Table 32  An array is in a Critical state

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Additional Information</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>One or more disks in the array have failed or been removed.</td>
<td>Due to the failed disk or disks, the array is no longer maintaining redundant (mirrored or parity) data. The failure of an additional disk results in an Offline state and lost data.</td>
<td>See Troubleshooting Disks on page 73.</td>
</tr>
</tbody>
</table>
### Table 33  An array is in an Offline state

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Additional Information</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The array has lost the maximum allowable disks per RAID level.</td>
<td>One or more disks have failed.</td>
<td>See Troubleshooting Disks on page 73</td>
</tr>
<tr>
<td>• If the array is non-redundant, the failure of a single disk causes the array to fail.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• If the array is redundant, the failure of two or more disks causes the array to fail.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The array cannot be restored (rebuilt).</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Table 34  Cannot assign a dedicated spare to an array

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Additional Information</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The RAID level does not allow dedicated spares.</td>
<td>Dedicated spares cannot be created for Volume or RAID0 arrays.</td>
<td>• Create an array with a different RAID level and assign a dedicated spare.</td>
</tr>
<tr>
<td>• Create an array with a different RAID level and assign a dedicated spare.</td>
<td></td>
<td>• Create a global spare.</td>
</tr>
<tr>
<td>The designated disk does not have sufficient capacity to be a dedicated spare.</td>
<td>The capacity of the disk selected to be a dedicated spare must be equal to or larger than the capacity of the smallest disk in the array.</td>
<td>Select a different disk.</td>
</tr>
</tbody>
</table>

### Table 35  Cannot create a global spare

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Additional Information</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The disk is already part of an array</td>
<td>A global spare cannot be selected if it is already part of an existing array.</td>
<td>Select a different disk.</td>
</tr>
<tr>
<td>There are no empty disks available or the disks have not been initialized</td>
<td>A disk with a legacy state can be initialized, if desired, but it is no longer legacy (initialization adds RAIDXpert2 configuration information to the disk).</td>
<td>• Install additional disks.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Initialize the disks.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>△ CAUTION: When a disk is initialized, all data on the disk is lost.</td>
</tr>
<tr>
<td>The disk assigned as the global spare has failed or is missing.</td>
<td></td>
<td>See Troubleshooting Disks on page 73</td>
</tr>
</tbody>
</table>
### Table 36 Cannot create an array larger than 2.199 TB

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Additional Information</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using an incorrect procedure to create an array larger than 2.199 TB with 32- or 64-bit Windows XP</td>
<td>There is a limit of 2.199 TB per array in the Windows architecture. Arrays larger than this do not operate properly. Microsoft Windows addresses this problem with dynamic disks: Disks greater than 2.199 TB can be created from groups of smaller arrays through the use of dynamic volumes. Dynamic volumes can be striped together using the Windows Disk Management utility, to create arrays larger than 2.199 TB from groups of smaller arrays.</td>
<td>Create a smaller array. Create an array on 32-or 64-bit Windows XP using the following procedure:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Determine how many arrays are needed. a. Divide the desired array size by 2.199 TB. Round down to the nearest whole number. The resulting number is the number of maximum-sized arrays needed. Example: Desired array size = 5 TB. Divide 5 by 2.199 = 2.27 Round down = 2 Create 2 maximum-sized arrays. b. If the division results in a number with a decimal, create one more array (the size of the remainder). Multiply the whole-number of arrays by 2.199. Subtract from the size of the desired array. The resulting number is the size of the remaining array. Example: Multiply 2 by 2.199 = 4.398 Subtract 4.398 from 5 = 0.602 The size of the remaining array must be 0.602 TB.</td>
</tr>
</tbody>
</table>

**NOTE:** This procedure requires converting disks to dynamic disks. In normal operation, this is not recommended. 7. Select the disks 8. Click Next>. 9. Click Finish. The arrays are displayed in the Computer Management window. 10. Right-click the first disk. 11. Click New Volume. 12. Click Next>. 13. Click Spanned. This type of volume merges the disks together. 14. Click Next>. The New Volume Wizard opens. 15. Choose the desired disks and the size of the resulting volume.  |
Table 36  Cannot create an array larger than 2.199 TB (continued)

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Additional Information</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>16. Click Next&gt;.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>17. Follow the normal formatting procedure for a disk.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>After the array initializes, it displays at the Computer Management window.</td>
</tr>
</tbody>
</table>

Table 37  Recreate a deleted array

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Additional Information</th>
<th>Corrective Actions</th>
</tr>
</thead>
</table>
| An array(s) was accidentally deleted, or the wrong array was deleted | This procedure might recreate a deleted array and with its data intact. However; this is not guaranteed to occur. If I/O was running to the deleted array(s) just prior to it being deleted, there might be some data loss in the recreated array(s). If multiple arrays were deleted, all of the deleted arrays must be recreated in order to recover the desired array. | 1. At the Array pop-up menu, select Create.  
2. Create a new array using the same settings as the deleted array.  
   - The same disks.  
   - The same RAID type (RAID level).  
   - The same capacity.  
   - The same cache options.  
3. Check Leave Existing Data Intact.  
4. Click Create.  
5. Ensure the settings are the same as the deleted array:  
   - The same drive letter.  
   - The same RAID type (RAID level).  
   - The same disks.  
   - The same capacity.  
   - The same cache option.  
6. Check the data files of the array for corrupted or missing files, incorrect file extensions, and so on. |

Disk-Related Errors

- Disk errors on page 72
- Troubleshooting Disks on page 73

Table 38  Disk errors

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Additional Information</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>A disk has been removed from an array</td>
<td></td>
<td>See Troubleshooting Disks on page 73.</td>
</tr>
<tr>
<td>A disk is not visible in the BIOS Configuration Utility or is offline</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A disk is highlighted red at the BIOS Configuration Utility</td>
<td>The disk has failed. Depending on the RAID level of the array, data might be lost.</td>
<td></td>
</tr>
<tr>
<td>RAIDXpert2 cannot communicate with the spare</td>
<td>The dedicated spare is not visible in the BIOS Configuration Utility or is offline.</td>
<td></td>
</tr>
</tbody>
</table>
| The disk cannot be initialized | Only disks that are Ready can be initialized.  

⚠️ CAUTION: When a disk is initialized, all data on the disk is lost.  

- Ensure the disk is not already a member of an array.  
- Ensure the disk is still assigned as a global or dedicated spare.  
- Ensure the disk is reporting a Ready state.
Troubleshooting Disks

Perform the following actions when there may be a problem with a disk.

- Ensure there is no damage to the system’s backplane.
- Ensure all cables are installed correctly.
- Ensure the disk is seated correctly in the backplane or bay and the latch is secured.
- Reinsert the disk.
- Replace the disk.
- After reconnecting, reseating, reinserting, or replacing a disk:
  - Perform a rescan.
  - Initialize the disk.

⚠️ **CAUTION:** When a disk is initialized, all data on the disk is lost.

If problems with a disk have caused an array to go Critical, it may be necessary to also assign a dedicated or global spare for the array.

If problems with a disk have caused an array to go Offline, data may have been lost. Recover lost data from a backup storage source.
Software License: End-User License Agreement (EULA)

BY INSTALLING, DOWNLOADING AND/OR USING THE SOFTWARE THAT ACCOMPANIES THIS END USER LICENSE AGREEMENT ("AGREEMENT") AND ANY ASSOCIATED DOCUMENTATION OR UPDATES THERETO ("SOFTWARE"), YOU AGREE THAT, WHETHER AS AN INDIVIDUAL OR AUTHORIZED REPRESENTATIVE OF AN ENTITY, YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT AND AGREE TO BE BOUND BY IT. IF YOU DO NOT AGREE TO IT, YOU ARE NOT AUTHORIZED TO INSTALL, DOWNLOAD OR OTHERWISE USE THE SOFTWARE AND ARE ASKED TO PLEASE RETURN THE SOFTWARE TO THE PARTY FROM WHOM YOU RECEIVED IT. THE RIGHT TO USE THE SOFTWARE IS GRANTED ONLY UPON THE CONDITION THAT YOU AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT.

FURTHER, YOU UNDERSTAND THAT THIS SOFTWARE MAY ONLY BE OBTAINED FROM Advanced Micro Devices, Inc. ("AMD") OR AN AUTHORIZED DISTRIBUTOR OF AMD. IF YOU OBTAINED THIS SOFTWARE FROM ANY OTHER SOURCE, THAT SOURCE PROVIDED IT TO YOU ILLEGALLY, AND YOU HAVE NO RIGHT TO INSTALL, DOWNLOAD OR OTHERWISE USE THE SOFTWARE; SUCH USE IS A VIOLATION OF INTELLECTUAL PROPERTY RIGHTS.

1. Limited License to Authorized Distributors

If you are an OEM, distributor, reseller, integrator or other entity in the business of providing technology products and/or services, and if you have been expressly authorized to distribute copies of the Software to End User(s), you are an "Authorized Distributor." Subject to the terms and conditions of this Agreement, you are granted a limited, non-exclusive, non-transferable, non-sublicensable license to distribute and/or install the Software in its unaltered, object code form solely (i) to, and on behalf of, a purchasing End User for the End User’s internal business purposes; and (ii) only for use with one (1) AMD product, purchased through authorized AMD sales channels. Except as specifically stated in this Section 1, Authorized Distributors are expressly prohibited from: copying and/or distributing the Software in whole or in part; using the Software to provide consulting or other services to third parties; and distributing the Software in any form or format. Authorized Distributors are subject to all other terms and conditions of this Agreement. Authorized Distributors must ensure that its End Users see and agree to this Agreement.

2. Limited License to End Users

If you have licensed the Software for your own personal use or your company's internal use, you are an "End User." You are hereby granted, subject to the terms and conditions of this Agreement, a limited, non-exclusive, non-transferable, non-sublicensable license to use this Software in its unaltered, object code form solely (i) for internal business purposes; and (ii) only with respect to one (1) AMD product that was purchased through authorized AMD sales channels. Further, you must obtain this Software only from authorized AMD sales channels. Obtaining it from any other source is a violation of the intellectual property rights of AMD and its licensors.

3. Restrictions

Except as expressly authorized in Sections 1 and 2 above, Authorized Distributors and End Users (collectively "You") shall not (nor cause or permit any other person to): (i) reverse engineer, translate, disassemble, derive source code from, decompile, rent, lease, manufacture, adapt, create derivative works from, or otherwise modify or distribute the Software or any part thereof; (ii) copy, in whole or in part, the Software with the exception that only End Users may make one copy of the Software for their backup or archival purposes; (iii) publicly display the Software or use the Software to provide consulting or other services to third parties; or (iv) delete any copyright, trademark, patent or other notices of proprietary rights as they appear anywhere in or on the Software.
4. Proprietary Rights

The Software is primarily the intellectual property of Dot Hill Systems Corp. ("Dot Hill") and its licensors ("Licensors"). In no event shall You obtain title to the Software or any component thereof. As between Dot Hill and You, Dot Hill has all rights, title, interest, ownership and proprietary rights in and to the Software. Dot Hill's rights include, but are not limited to, all copies of the Software and any patent rights, copyrights, trademark rights, trade secret rights, and any other intellectual property right recognized in any country or jurisdiction in the world. The Software is protected both by United States law and international treaty provisions. All rights not expressly granted in this Agreement are reserved by Dot Hill and Licensors, respectively.

5. Term and Termination

This Agreement shall continue in effect until terminated. Dot Hill or AMD may terminate this Agreement immediately if You fail to comply with any provision of this Agreement. Upon termination, You shall discontinue use of the Software, and either destroy, erase, or return all copies of the Software in Your possession or control.

6. No Warranty

THE SOFTWARE IS PROVIDED "AS IS" WITHOUT ANY WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. DOT HILL AND AMD DISCLAIM, ON THEIR OWN BEHALF AND ON BEHALF OF LICENSORS, ANY EXPRESS OR IMPLIED WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF NONINFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OF THE SOFTWARE OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE OR WILL OPERATE IN COMBINATION WITH OTHER SOFTWARE OR HARDWARE. Dot Hill and its Licensors will not provide support for the Software and, to the extent you believe that are entitled to support, you are advised to contact the party from whom you received the Software. Notwithstanding the foregoing, Updates to the Software (which may or may not be distributed) shall be governed by this Agreement, and such Updates will be considered Software for purposes of this Agreement.

The Software is not absolutely fault-tolerant and is not designed, manufactured or intended for use or resale as on-line control equipment in hazardous environments requiring fail-safe performance in which the failure of the Software could lead directly to death, personal injury or severe physical or environmental damage, such as the operation of nuclear facilities, aircraft navigation, air traffic control, direct life support machines, or weapons systems ("High Risk Activities"). Express or implied warranties for High Risk Activities are specifically disclaimed.

7. Limitation of Liability

IN NO EVENT SHALL DOT HILL, AMD OR LICENSORS BE LIABLE TO ANY PARTY FOR ANY LOST REVENUE, LOST PROFIT OR DATA, OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED, AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE EVEN IF THEY HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL DOT HILL’S, AMD’s or LICENSORS’ LIABILITY, TO YOU, WHETHER IN CONTRACT, TORT (INCLUDING NEGLIGENCE) OR OTHERWISE, EXCEED THE AMOUNT OF ANY FEE PAID BY YOU FOR THE SOFTWARE. THE FOREGOING LIMITATIONS SHALL APPLY EVEN IF THE REMEDY FAILS OF ITS ESSENTIAL PURPOSE. Some jurisdictions do not allow for the exclusion of implied warranties as described in Section 6, or the limitation of liabilities as described in this Section 7, so the above exclusions or limitations may not apply to You. In that event, to the extent permissible, any exclusion of warranties or limitation of liability will be limited in duration or type to the greatest extent allowed by law.

8. Export Controls

You agree to comply fully with all relevant export laws, regulations, treaties, and orders ("Export Laws") to assure that neither the Software nor any components thereof are (i) exported, directly or indirectly, in violation of Export Laws; or (ii) are intended to be used or are used for any purposes prohibited by the Export Laws.
9. General

This Agreement and any disputes arising from or relating to it shall be governed by and construed in accordance with the laws of the State of Colorado without reference to conflict of laws principles and excluding the U.N. Convention on Contracts for the International Sale of Goods. Any legal action or proceeding shall be instituted in a state or federal court in Denver, Colorado, U.S.A. and You agree to be subject to the jurisdiction of these courts. Taxes and charges imposed by any government with respect to the Software shall be paid by the End User. The waiver by either party of a breach of this Agreement or a failure to exercise any right hereunder shall not operate or be construed as a waiver of any subsequent breach or as a waiver of any other right. If any provision of this Agreement is held to be unenforceable or overbroad for any reason, it will be modified rather than voided, if possible, in order to achieve the intent of the parties to the extent necessary to make the provision enforceable under applicable law, and enforced as amended. In any event, all other provisions of this Agreement will be deemed valid and enforceable to the full extent. This Agreement constitutes the complete agreement between the parties and supersedes all prior or contemporaneous agreements or representations, written or oral, concerning the subject matter of this Agreement including any purchase order or ordering document. This Agreement may not be modified or amended except in writing and signed by both parties.
What is rcadm?

The rcadm program is a command line interface (CLI) tool for managing RAIDXpert2 in the Windows, Linux, or EFI operating system.

The rcadm program initiates RAIDXpert2 operations, such as:

• Manage RAIDXpert2, arrays and disks (see page 80).
• Create new arrays (see page 82).
• Delete arrays (see page 83).
• Transform arrays (see page 83) (supported by RAIDXpert2 Plus).
• Follow or monitor arrays and disks (see page 84).
• Information on drive and array states.

The rcadm program has seven primary modes, with most primary modes having additional optional arguments. The seven modes of operation are indicated in Table 39.

### Table 39  Modes for the rcadm program

<table>
<thead>
<tr>
<th>Mode</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage</td>
<td>Uses the <code>rcadm --manage</code> command to manage and query RAIDXpert2, arrays, and disks.</td>
</tr>
<tr>
<td>Create</td>
<td>Uses the <code>rcadm --create</code> command to create a new array.</td>
</tr>
<tr>
<td>Delete</td>
<td>Uses the <code>rcadm --delete</code> command to delete arrays.</td>
</tr>
<tr>
<td>Transform</td>
<td>Uses the <code>rcadm --transform</code> command to transform an array. (supported by RAIDXpert2 Plus)</td>
</tr>
<tr>
<td>Follow</td>
<td>Uses the <code>rcadm --follow</code> command to follow or monitor arrays and disks.</td>
</tr>
<tr>
<td>Split</td>
<td>Uses the <code>rcadm --split</code> command to split mirrored arrays into separate arrays.</td>
</tr>
<tr>
<td>Create Copy</td>
<td>Uses the <code>rcadm --create-copy</code> command to create a new array and then copy the specified array data to the new array of equal or greater capacity.</td>
</tr>
</tbody>
</table>

Follow these instructions to issue the command on the operating system. Also see View Help from the Command Line on page 82.

**To Use rcadm with a Linux OS**

By default, rcadm is installed in `/usr/bin`.

**To Use rcadm with a Windows OS**

- Change directories to `%Program Files%\RAIDXpert2`.
- Run the `rcadm.exe` command from there.
  
or
- Add `%Program Files%\RAIDXpert2` to the system or user path environment variables.
Manage Arrays and Disks: rcadm --manage

The `rcadm --manage` or `rcadm -M` command allows the user to view information about RAIDXpert2 and manage the arrays and disks.

For example, the user can:
- Set cache attributes for arrays.
- Set priority levels for tasks on an array.
- Hide and unhide arrays.
- List arrays.
- Initialize disks.
- Query information about disks.
- Add and remove spares from an array.
- Set cache attributes for disks.

Understand Query Output

When the `rcadm --manage --query-all` command is used, information about the disks and arrays for the system is displayed.

To see information about a specific controller, disk, or array use the `rcadm --manage --query` command, in conjunction with the appropriate options.

**rcadm Controller List Elements**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Controller number assigned by RAIDXpert2.</td>
</tr>
<tr>
<td>Type</td>
<td>Model number of the controller.</td>
</tr>
<tr>
<td>Serial Number</td>
<td>Serial number of the controller.</td>
</tr>
<tr>
<td>Port Count</td>
<td>The number of ports supported by RAIDXpert2.</td>
</tr>
<tr>
<td>PCIe Vendor ID</td>
<td>The PCIe vendor identification number.</td>
</tr>
<tr>
<td>PCIe Device ID</td>
<td>The PCIe device identification number.</td>
</tr>
<tr>
<td>PCIe SubVendor ID</td>
<td>The PCIe sub-vendor identification number.</td>
</tr>
<tr>
<td>PCIe SubDevice ID</td>
<td>The PCIe sub-device identification number.</td>
</tr>
<tr>
<td>SAS Address (WWID)</td>
<td>The SAS Address (world-wide identification number).</td>
</tr>
<tr>
<td>BIOS Version</td>
<td>The version of the AMD-RAID Configuration BIOS.</td>
</tr>
</tbody>
</table>

**rcadm Disk List Elements**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk</td>
<td>Disk number assigned by RAIDXpert2, corresponding to the SATA channel ID.</td>
</tr>
<tr>
<td>State</td>
<td>State of the disk (Online, Failed, Unknown).</td>
</tr>
<tr>
<td>Disk Type</td>
<td>Disk type (Disk, Legacy, New, ATAPI).</td>
</tr>
<tr>
<td>Port Type</td>
<td>Port type (SATA, SATA II, eSATA, SSD).</td>
</tr>
<tr>
<td>Port Speed</td>
<td>The negotiated speed of the port.</td>
</tr>
</tbody>
</table>
### rcadm Disk List Elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
</table>
| Size        | Total size of the disk:  
  - 1 MB = 1,000,000 bytes  
  - 1 GB = 1,000,000,000 bytes  
  
  **NOTE:** Because the ATA storage industry has standardized the meanings of MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2 reports the same units. |
| Free Space  | Total amount of space unused on the disk. |
| Largest Free Space | Largest contiguous unused space on the disk. |
| GS          | Indicates if the disk is assigned as a global spare. |
| Ca          | Current disk cache setting (NC = No Cache, R = Read Cache, W = Write Back Cache, RW = Read + Write Back Cache). |
| Ctrl Chan   | Disk controller and channel number. |
| Vendor      | Disk vendor. |
| Model Number| Disk model number. |
| Firmware Version | Disk firmware version. |
| Serial Number | Disk serial number. |

### rcadm Array List Elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Array number assigned by RAIDXpert2.</td>
</tr>
<tr>
<td>Type</td>
<td>RAID type.</td>
</tr>
<tr>
<td>O.S. Name</td>
<td>Name assigned by the operating system to the array. The name shows as “Hidden” if the array is hidden from the operating system. The name shows “??” if the array is Offline.</td>
</tr>
<tr>
<td>Sys or System Device</td>
<td>Indicates whether or not the array is being used as a system disk under Windows.</td>
</tr>
<tr>
<td>State</td>
<td>State of the array (Normal, Critical, Offline).</td>
</tr>
</tbody>
</table>
| Size or Capacity | Total size of the disk:  
  - 1 MB = 1,000,000 bytes  
  - 1 GB = 1,000,000,000 bytes  
  
  **NOTE:** Because the ATA storage industry has standardized the meanings of MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2 reports the same units. |
| Hide        | Whether the array is hidden from the operating system. |
| Id          | Globally unique identifier for the array assigned by RAIDXpert2. |
View Help from the Command Line

To view a list of the major modes of operation

Type: `rcadm --help` or `rcadm -?`

To view help for a specific mode and its options

Type: `rcadm <mode> --help` or `rcadm <mode> -?`

For example, typing `rcadm --manage --help` displays help and examples regarding that specific mode and its options.

To view the rcadm man page on a Linux system

Type: `man rcadm`

Create New Arrays: `rcadm --create`

The `rcadm --create` or `rcadm -C` command allows new arrays to be created. As many as eight arrays can be partitioned and created across all disks.

Portions of disks can be used to create arrays, while other arrays are using different portions of the same disks. A maximum of eight arrays can be created.
Before you begin...

Creation of arrays, even redundant arrays, allows users immediate access to the arrays. If the system reboots, the creation process continues where it left off.

⚠️ CAUTION: In some circumstances, more than eight arrays are possible. They might appear to function properly, but are not supported.

🔍 NOTE: The array size of the new array is limited to 2.199 TB with some operating systems. Refer to the operating system documentation for details on maximum array sizes.

🔍 NOTE: The ability to create RAID10 or RAIDABLE arrays may not be available on your system.

Example

To create a 1 GB RAID5 array using disk members 1, 2, and 3, type: `rcadm -C -r5 -d 1 2 3 -s 1000`

To see more examples, type: `rcadm -C -?`

Delete Arrays: `rcadm --delete`

The `rcadm --delete` or `rcadm -D` command allows the user to delete one or more arrays.

⚠️ CAUTION: Deleting an array permanently destroys all data that is on the array. This action cannot be undone and it is very unlikely the data can be recovered.

Before you begin...

- If the operating system is using an array it cannot be deleted.
- If an array is accidentally deleted, and the user wants to try and recover the data, create an array using the same disks, same size, and same cache, and use the `--leave-existing-data` option. This option writes new configuration information to the array while trying to use the exact same disk space as before.

Example

To delete array 1, type: `rcadm -D -a 1`

To see more examples, type `rcadm -D -?`

Transform Arrays: `rcadm --transform` (supported by RAIDXpert2 Plus)

The `rcadm --transform` or `rcadm -T` command allows the user to transform (migrate) an array from one RAID level to almost any other RAID level, and to expand the array dynamically, even under I/O load.

Before you begin...

- An array cannot be transformed to a smaller-sized array. New arrays must be either the same capacity or larger.
- When using the task control option, a Transform can only be paused or resumed but not removed.
- If a spare has been assigned to the destination array, a fail-over task starts as soon as the Transform completes, provided the spare is available after the Transform.
- If there are multiple arrays on a single controller, it might not be possible to transform some of the arrays to a larger size. If the size of an array might be expanded in the future, it is best to configure the available space as a single array.
- The array size of the transformed array is limited to 2.199 TB on some operating systems.
Follow or Monitor Arrays and Disks: rcdm --follow

The rcdm --follow or rcdm -F command allows the user to follow or monitor arrays and disks. It polls the RAID subsystem for any changes in status and sends an e-mail notification and/or executes a specified program. The output of this command is logged to the System Event Log on Windows.

Before you begin...

It is recommended that the user not run more than one instance of rcdm --follow at the same time. If the user runs more than one instance of the command, each instance captures some of the events but no single instance captures all events.
## Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>rcdm</td>
<td>A command line interface (CLI) tool for managing RAID controllers Linux, on Windows, and UEFI operating systems. It is used for creating, transforming, and deleting arrays; and adding and removing disks.</td>
</tr>
</tbody>
</table>
| legacy disk                 | Legacy disks include new or unrecognized disks which may contain data or even an operating system. Legacy disks appear in the BIOS Configuration Utility and in RAIDXpert2 as legacy arrays. When the legacy disk is initializing, configuration data is written to the disk. The legacy array then becomes an online disk usable in arrays.  
   \[\text{CAUTION:}\] A legacy disk can contain valid data. When a legacy disk is initialized, all data on the disk is lost. |
| Linux                       | Free, open-source UNIX-based operating system.                             |
| OCE (Online Capacity Expansion) | A feature (available with a RAIDXpert2 Plus license) that allows users to add up to 12 disks to an array at any time and continue to access data while it is being redistributed. |
| ORLM (Online RAID Level Migration) | A feature (available with a RAIDXpert2 Plus license) that allows users to move from one RAID level to another. While the migration is taking place, data is accessible and protected to the lowest protection of either the source RAID level or the destination RAID level. |
Index

A
About and Help windows 46
application workload 25
array
details, viewing 32
list elements for rcadm 81
rcadm list elements 81
viewing details 32
Array Status window
Array List section 48
Array View section 47
Disk List section 47
Event View section 49
Array View section, Array Status window 47
arrays
array states 20
assessing additional space 56
cache setting, changing 58
cannot create an array 69
checking consistency 59
commands at RAIDXpert2 49
continue booting from the BIOS Configuration Utility 33
create and format 52
create from the BIOS Configuration Utility 29
creating 52
delete 57
deleted array, how to recreate 58
expansion, future 21
formatting 52
migration 57
naming 54
partitioning 54
partitioning and formatting 54
physical removal, preparation 57
rebuilding (restoring) a Critical array 56
recreating a deleted array 72
restoring (rebuilding) a Critical array 56
scanning in the background 61
sparing options 24
tasks, starting and stopping 22
tasks. starting and stopping 21
transform, using rcadm 83
transforming 54
understanding their purpose 19
Arrays Status section, Array Status window 48
audience
intended 9
who should use this user manual 13
B
backup strategy 25
BIOS Configuration Utility
access 27
arrays, creation of 29
arrays, deletion of 30
arrays, swapping 30
arrays, viewing details 32
color codes 27
continue booting 33
controller options 32
disks, initialization of 28
disks, viewing details 31, 32
rescan all channels 32
spinup count, changing 33
when to use 27
C
cache
attributes 25
cache settings
changing 58
changing for disks 51
color codes, BIOS Configuration Utility 27
commands, RAIDXpert2, array and disk 49
consistency checks
arrays 59
scheduling 60
controller list elements, using rcadm 80
controller options, changing 32
conventions
document 9
create task, arrays 52
D
data, redundancy 25
dedicated spares
adding 61
removing 61
dedicated sparing 24
delete arrays
BIOS Configuration Utility 30
how to recreate 58
how to recreate it 72
using rcadm 83
Disk List section, Array Status window 47
disks
capacity, online, expanding (OCE) 21
changing cache settings 51
commands at RAIDXpert2 49
details, BIOS Configuration Utility 31, 32
disk states 22
initialization 50
legacy and new 52
legacy, using them 52
list elements, for rcadm 80
number and organization 25
rcadm list elements 80
rescanning 51
rescanning, for changes in state 23
errors, physical disks
  cannot initialize a disk 72
  dedicated hot spare has failed or is in error 72
  Failed status is displayed 72
  the wrong disk was removed 72
event notifications
  setting 64
Event View section, Array Status window 49
expand
  arrays, future 21
  disk capacity online (OCE) 21
  future, arrays 21
flexibility and expansion 25
follow arrays, using rcadm 84
formatting arrays, with Windows Disk Management 54
global spares
  adding 61, 62, 63
  removing 61, 62, 63
  global sparing 24
Help and About windows 46
hot spares, cannot create 70
initialize disks 50
  BIOS Configuration Utility 28
  INT13 disabled, warning message 68
legacy disks 52
  usage 52
  logs, viewing 63
monitor arrays, using rcadm 84
new arrays, create, using rcadm 82
new disks 52
OCE (Online Capacity Expansion) 21
operating systems, supported by AMD-RAID 13
Options menu, changing a password 46
delete arrays 83
disk list elements 80
follow arrays 84
manage arrays and disks 80
monitor arrays 84
transform arrays 83
understanding query output 80
viewing Help 82
what it is 79
rebuild (restore) task
  rebuilding (restoring) a Critical array 56
redundancy, data 25
reliability considerations 25
remote management
  setting up 64
rescan
  all channels 32
  disks 51
  for changes in state 23
restore (rebuild) task
  restoring (rebuilding) a Critical array 56

S
spares
  dedicated, adding 61
  dedicated, removing 61
  global, adding 61, 62, 63
  global, removing 61, 62, 63
sparing
  dedicated 24
  global 24
spinup count, changing 33
staggered spinup count, changing 33
swap arrays, BIOS Configuration Utility 30
system requirements, for RAIDXpert2 13
system, startup problems 67

T
tasks
  canceling 59
  interrupting 59
  priority level, changing 59
Troubleshooting
  a dedicated hot spare has failed 72
  a disk has failed 72
  BIOS Configuration Utility does not display 67
  cannot create a global hot spare 70
  cannot create an array 69
  cannot initialize a disk 72
  recreating a deleted array 72
  system does not boot 67
  system startup problems 67
  the wrong disk was removed 72
warning messages, POST screen 68

U
user manual, who should use it 13

V
view help, from the rcadm Command Line 82
virtual disks
  errors 69
  troubleshooting 69
volumes, larger than 2 TB with Windows Server 2003 71

W
warning messages, POST screen 68
  BIOS Not Installed - User Disabled INT13 BIOS Load 68
  Found arrays that are Critical 68
  Found arrays that are Critical and Offline 68
  Found arrays that are Offline 68

RAIDXpert2 User Guide 89